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Гарантия
Компания Tektronix гарантирует отсутствие в данном изделии дефектов в материалах и изготовлении в течение 1 (одного) года со
дня приобретения. Если в течение гарантийного срока в таком изделии будут обнаружены дефекты, компания Tektronix, по
своему выбору, либо устранит неисправность в дефектном изделии без дополнительной оплаты за материалы и потраченное на
ремонт рабочее время, либо произведет замену неисправного изделия на исправное. Компоненты, модули и сменные части,
используемые компанией Tektronix для работ, выполняемых по гарантии, могут быть как новыми, так и восстановленными с
такими же эксплуатационными характеристиками, как у новых. Все замененные части, модули и изделия становятся
собственностью компании Tektronix.

Для реализации права на обслуживание в соответствии с данной гарантией необходимо до истечения гарантийного срока
уведомить компанию Tektronix об обнаружении дефекта и выполнить необходимые для проведения гарантийного обслуживания
действия. Ответственность за упаковку и доставку неисправного изделия в центр гарантийного обслуживания компании Tektronix,
а также предоплата транспортных услуг возлагается на владельца. Компания Tektronix оплачивает обратную доставку исправного
изделия заказчику только в пределах страны, в которой расположен центр гарантийного обслуживания. Доставка исправного
изделия по любому другому адресу должна быть оплачена владельцем изделия, включая все расходы по транспортировке,
пошлины, налоги и любые другие расходы.

Данная гарантия не распространяется на случаи, когда дефект, отказ в работе или повреждение изделия вызваны неправильной
эксплуатацией, хранением или обслуживанием изделия. Компания Tektronix не обязана по данному гарантийному обязательству:
а) исправлять повреждения, вызванные действиями любых лиц (кроме инженеров Tektronix) по установке, ремонту или
обслуживанию изделия; б) исправлять повреждения, вызванные неправильным использованием изделия или подключением его к
несовместимому оборудованию; в) исправлять повреждения или неполадки, вызванные использованием материалов, не
рекомендованных Tektronix, а также г) обслуживать изделие, подвергшееся модификации или интегрированное в иное
оборудование таким образом, что эти действия увеличили время или сложность обслуживания изделия.

ДАННАЯ ГАРАНТИЯ ПРЕДОСТАВЛЯЕТСЯ TEKTRONIX НА ДАННОЕ ИЗДЕЛИЕ НА УСЛОВИЯХ ЗАМЕНЫ ЛЮБЫХ ДРУГИХ
ГАРАНТИЙ, ДАННЫХ ЯВНО ИЛИ ПОДРАЗУМЕВАВШИХСЯ. КОМПАНИЯ TEKTRONIX И ЕЕ ПОСТАВЩИКИ ОТКАЗЫВАЮТСЯ ОТ
ЛЮБЫХ ДРУГИХ ПОДРАЗУМЕВАЕМЫХ ГАРАНТИЙ ТОВАРНОГО СОСТОЯНИЯ ИЛИ ПРИГОДНОСТИ ПРОГРАММЫ ДЛЯ
ДРУГИХ ЦЕЛЕЙ. ОТВЕТСТВЕННОСТЬ КОМПАНИИ TEKTRONIX ПО ДАННОМУ ГАРАНТИЙНОМУ ОБЯЗАТЕЛЬСТВУ
ОГРАНИЧИВАЕТСЯ ТОЛЬКО РЕМОНТОМ ИЛИ ЗАМЕНОЙ ДЕФЕКТНЫХ ИЗДЕЛИЙ ЗАКАЗЧИКАМ. КОМПАНИЯ TEKTRONIX И ЕЕ
ПОСТАВЩИКИ НЕ НЕСУТ ОТВЕТСТВЕННОСТИ ЗА КОСВЕННЫЙ, СПЕЦИФИЧЕСКИЙ ИЛИ КАКОЙ-ЛИБО ОПОСРЕДОВАННЫЙ
УЩЕРБ ДАЖЕ В ТОМ СЛУЧАЕ, ЕСЛИ ПРЕДСТАВИТЕЛИ КОМПАНИИ TEKTRONIX БЫЛИ ЗАРАНЕЕ УВЕДОМЛЕНЫ О
ВОЗМОЖНОСТИ ТАКОГО УЩЕРБА.
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Гарантия
Корпорация Tektronix гарантирует отсутствие в носителях, на которых поставляется этот программный продукт, и коде программ
на этих носителях дефектов в материалах и изготовлении в течение трех (3) месяцев со дня приобретения. Если в течение
гарантийного срока в любом носителе или коде будут обнаружены дефекты, корпорация Tektronix заменит носитель на
исправный. За исключением носителей, используемых для поставки, данный программный продукт предоставляется «как есть»
без каких-либо гарантий, явных или подразумеваемых. Tektronix не гарантирует соответствие функций данного программного
обеспечения требованиям Заказчика или бесперебойную работу программ и отсутствие ошибок.

Для реализации своего права на обслуживание в соответствии с данной гарантией необходимо до истечения гарантийного срока
уведомить корпорацию Tektronix об обнаружении дефекта. Если в течение разумного времени после этого в Tektronix не смогут
обеспечить замену неисправного компонента на элемент с отсутствием дефектов в материалах и изготовлении, Заказчик может
отказаться от лицензии на этот программный продукт и вернуть его и все связанные с ним материалы для получения обратно
уплаченных денег.

ДАННАЯ ГАРАНТИЯ ПРЕДОСТАВЛЯЕТСЯ TEKTRONIX НА ДАННОЕ ИЗДЕЛИЕ НА УСЛОВИЯХ ЗАМЕНЫ ЛЮБЫХ ДРУГИХ
ГАРАНТИЙ, ДАННЫХ ЯВНО ИЛИ ПОДРАЗУМЕВАВШИХСЯ. КОМПАНИЯ TEKTRONIX И ЕЕ ПОСТАВЩИКИ ОТКАЗЫВАЮТСЯ ОТ
ЛЮБЫХ ДРУГИХ ПОДРАЗУМЕВАЕМЫХ ГАРАНТИЙ ТОВАРНОГО СОСТОЯНИЯ ИЛИ ПРИГОДНОСТИ ПРОГРАММЫ ДЛЯ
ДРУГИХ ЦЕЛЕЙ. ОТВЕТСТВЕННОСТЬ КОРПОРАЦИИ TEKTRONIX ПО ДАННОМУ ГАРАНТИЙНОМУ ОБЯЗАТЕЛЬСТВУ
ОГРАНИЧИВАЕТСЯ ТОЛЬКО ЗАМЕНОЙ НЕИСПРАВНЫХ НОСИТЕЛЕЙ ИЛИ ВОЗВРАЩЕНИЕМ УПЛАЧЕННЫХ СРЕДСТВ
ЗАКАЗЧИКУ. КОМПАНИЯ TEKTRONIX И ЕЕ ПОСТАВЩИКИ НЕ НЕСУТ ОТВЕТСТВЕННОСТИ ЗА КОСВЕННЫЙ,
СПЕЦИФИЧЕСКИЙ ИЛИ КАКОЙ-ЛИБО ОПОСРЕДОВАННЫЙ УЩЕРБ ДАЖЕ В ТОМ СЛУЧАЕ, ЕСЛИ ПРЕДСТАВИТЕЛИ
КОМПАНИИ TEKTRONIX БЫЛИ ЗАРАНЕЕ УВЕДОМЛЕНЫ О ВОЗМОЖНОСТИ ТАКОГО УЩЕРБА.
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Лицензионное соглашение

ВАЖНО — ПЕРЕД НАЧАЛОМ РАБОТЫ ОЗНАКОМЬТЕСЬ С СОДЕРЖАНИЕМ
РУКОВОДСТВА

Хранение этого программного обеспечения больше тридцати (30) дней или использование его любым способом
означает принятие условий лицензионного соглашения.

ВНИМАТЕЛЬНО ОЗНАКОМЬТЕСЬ С ПРИЛАГАЕМЫМ ЛИЦЕНЗИОННЫМ СОГЛАШЕНИЕМ. Если вы не можете
принять условия лицензионного соглашения, обратитесь в региональное отделение компании Tektronix за помощью.

ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ ДЛЯ ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ
TEKTRONIX

ПРОГРАММА ИЛИ ПРОГРАММЫ, ВСТРОЕННЫЕ В ОБОРУДОВАНИЕ, ПОСТАВЛЯЮТСЯ НА УСЛОВИЯХ
НАСТОЯЩЕГО СОГЛАШЕНИЯ. ХРАНЕНИЕ ДАННОГО ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ ИЛИ ЕГО
ИСПОЛЬЗОВАНИЕ ЛЮБЫМ СПОСОБОМ БОЛЕЕ ТРИДЦАТИ ДНЕЙ ОЗНАЧАЕТ ПРИНЯТИЕ УСЛОВИЙ
ЛИЦЕНЗИОННОГО СОГЛАШЕНИЯ. ЕСЛИ ЭТИ УСЛОВИЯ НЕПРИЕМЛЕМЫ, НЕИСПОЛЬЗУЕМЫЕ ПРОГРАММЫ И
СОПРОВОДИТЕЛЬНАЯ ДОКУМЕНТАЦИЯ К НИМ ДОЛЖНЫ БЫТЬ СРОЧНО ВОЗВРАЩЕНЫ КОМПАНИИ TEKTRONIX
ДЛЯ ПОЛНОГО ВОЗМЕЩЕНИЯ СТОИМОСТИ ПРИОБРЕТЕННОЙ ЛИЦЕНЗИИ. (СВЕДЕНИЯ О ВОЗВРАЩЕНИИ
ПРОГРАММ, ЗАПИСАННЫХ В ОБОРУДОВАНИИ ИЛИ ВСТРОЕННЫХ В НЕГО, МОЖНО ПОЛУЧИТЬ В БЛИЖАЙШЕМ
ТОРГОВОМ ПРЕДСТАВИТЕЛЬСТВЕ TEKTRONIX)

ОПРЕДЕЛЕНИЯ. «Tektronix» — Tektronix, Inc., корпорация, находящаяся в штате Орегон, или местное отделение
Tektronix, имеющее статус юридического лица и поставляющее оборудование.

«Заказчик» — лицо или организация, оформившие заказ на Программу.

ЛИЦЕНЗИЯ. Заказчик имеет право на следующее.

1. Использовать Программу на одном компьютере единовременно.

2. Если Программа предоставлена по лицензии со свободным выбором пользователя, ее можно копировать на
несколько компьютеров при условии, что каждый пользователь авторизован, а общее единовременное число
пользователей не превышает числа, указанного в лицензии.

3. Изменять Программу или объединять ее с другой программой для использования на одном компьютере.

4. Копировать Программу в целях архивирования при условии, что делается не больше одной (1) копии
единовременно. Если Программа предоставлена по лицензии со свободным выбором пользователя, она может
копироваться на несколько компьютеров для использования авторизованными пользователями.

Каждая копия Программы, сделанная Заказчиком, должна включать уведомления об авторском праве или об
ограничении прав, имеющиеся в копии Программы, полученной от компании Tektronix.

Заказчик не имеет права на следующие действия.

1. Использовать программу более чем на одном компьютере единовременно, если только это не разрешено
лицензией со свободным выбором пользователя или лицензией для отдельного места.

2. Передавать Программу любому лицу или организации за пределами компании Заказчика или корпорации, в которую
входит компания Заказчика, без предварительного письменного согласия компании Tektronix, кроме случаев
передачи оборудования с встроенными программами.

3. Экспортировать или реэкспортировать, прямо или косвенно, Программу, любую сопроводительную документацию
или непосредственно продукт в любую страну, в которую такой экспорт или реэкспорт ограничен согласно закону
или постановлению Соединенных Штатов или любого иностранного правительства, имеющего юрисдикцию, не
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требующую предварительной авторизации. Решение об ограничении экспорта может принимать Управление
экспортной администрации Министерства торговли США, Вашингтон, округ Колумбия, или соответствующее
агентство иностранного правительства.

4. Только для Программ с объектным кодом: выполнять обратную компиляцию или деассемблировать Программу для
каких-либо целей.

5. Копировать сопроводительную документацию к Программе.

Для Программ, разработанных для установки на одном компьютере и поддержки одного или нескольких дополнительных
компьютеров либо локально, либо удаленно, без разрешения перемещать Программу на дополнительный компьютер
для локального выполнения дополнительные компьютеры должны рассматриваться в пределах определения «один
компьютер». Для программ, разрешающих перемещать Программу на дополнительный компьютер для локального
выполнения, требуется отдельная лицензия для каждого такого компьютера, с которого Программа может
использоваться, или для каждого параллельного пользователя, авторизованного по лицензии со свободным выбором
пользователя.

Права на Программу и на все ее копии, но не на носители, на которых хранится Программа или копии, должны
принадлежать компании Tektronix или другим компаниям, которым компания Tektronix предоставила лицензию.

Заказчик обязан в должное время оплачивать все имущественные налоги, которыми Программа облагается в настоящее
время или будет облагаться в будущем, в соответствии с оценкой владения Программой, использования ее или
настоящей лицензии, а также сохранять все отчеты, требующиеся в связи с указанными налогами.

На любую часть Программы, измененную Заказчиком или объединенную с другой программой, должны
распространяться условия настоящего соглашения.

Если Программа приобретена агентством правительства США или для этого агентства, ее нужно считать программным
продуктом, разработанным на частные средства, а предоставленная при этих обстоятельствах лицензия должна
рассматриваться как предоставление Заказчику ограниченных прав на Программу и сопроводительную документацию,
как определено в соответствующих условиях приобретения.

ПРОГРАММА МОЖЕТ ИСПОЛЬЗОВАТЬСЯ, КОПИРОВАТЬСЯ, ИЗМЕНЯТЬСЯ, ОБЪЕДИНЯТЬСЯ ИЛИ
ПЕРЕДАВАТЬСЯ ДРУГОМУ ПОЛЬЗОВАТЕЛЮ ТОЛЬКО В ПОЛНОМ СООТВЕТСТВИИ С УСЛОВИЯМИ НАСТОЯЩЕГО
СОГЛАШЕНИЯ.

ПОСЛЕ ПЕРЕДАЧИ ЛЮБОЙ КОПИИ, МОДИФИЦИРОВАННОЙ ПРОГРАММЫ ИЛИ ОБЪЕДИНЕННОЙ ЧАСТИ
ПРОГРАММЫ ЛИЦЕНЗИЯ, ПРЕДОСТАВЛЕННАЯ НА УСЛОВИЯХ НАСТОЯЩЕГО СОГЛАШЕНИЯ, АВТОМАТИЧЕСКИ
АННУЛИРУЕТСЯ.

СРОК ДЕЙСТВИЯ. Предоставляемая лицензия действительна после принятия Заказчиком ее условий и остается в силе
до ее отмены в соответствии с условиями настоящего соглашения. Действие лицензии может быть прекращено
Заказчиком в любое время после письменного уведомления представителей компании Tektronix. Действие лицензии
может быть прекращено компанией Tektronix или третьим лицом, от которого компания Tektronix получила
соответствующее право лицензирования, если Заказчик нарушил какое-либо условие и не исправил нарушение в
течение тридцати (30) дней после уведомления о необходимости сделать это от компании Tektronix или
уполномоченного третьего лица. После прекращения любой стороной действия лицензии Заказчик должен возвратить
компании Tektronix Программу или уничтожить ее, равно как и всю сопутствующую документацию и все копии в любой
форме.

ОГРАНИЧЕННАЯ ГАРАНТИЯ. Корпорация Tektronix гарантирует отсутствие в носителях, на которых поставляется этот
программный продукт, и коде программ на этих носителях дефектов в материалах и изготовлении в течение трех (3)
месяцев со дня приобретения. Если в течение гарантийного срока в любом носителе или коде будут обнаружены
дефекты, корпорация Tektronix заменит носитель на исправный. За исключением носителей, используемых для
поставки, данная Программа предоставляется «как есть»: без каких-либо гарантий, явных или подразумеваемых.
Компания Tektronix не гарантирует соответствие функций данной Программы требованиям Заказчика или
бесперебойную работу Программы и отсутствие ошибок.
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Для реализации своего права на обслуживание в соответствии с данной гарантией необходимо до истечения
гарантийного срока уведомить корпорацию Tektronix об обнаружении дефекта. Если в течение адекватного периода
времени после этого компания Tektronix не сможет обеспечить замену неисправного компонента на элемент с
отсутствием дефектов в материалах и изготовлении, Заказчик может отказаться от лицензии на эту Программу и
вернуть ее и все связанные с ней материалы для возврата уплаченных средств.

ДАННАЯ ГАРАНТИЯ ПРЕДОСТАВЛЯЕТСЯ TEKTRONIX НА ДАННОЕ ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ НА УСЛОВИЯХ
ЗАМЕНЫ ЛЮБЫХ ДРУГИХ ГАРАНТИЙ, ЯВНЫХ ИЛИ ПОДРАЗУМЕВАЕМЫХ. КОМПАНИЯ TEKTRONIX И ЕЕ
ПОСТАВЩИКИ ОТКАЗЫВАЮТСЯ ОТ ЛЮБЫХ ДРУГИХ ПОДРАЗУМЕВАЕМЫХ ГАРАНТИЙ ТОВАРНОГО
СОСТОЯНИЯ ИЛИ ПРИГОДНОСТИ ПРОГРАММЫ ДЛЯ ДРУГИХ ЦЕЛЕЙ. ОТВЕТСТВЕННОСТЬ КОРПОРАЦИИ
TEKTRONIX ПО ДАННЫМ ГАРАНТИЙНЫМ ОБЯЗАТЕЛЬСТВАМ ОГРАНИЧИВАЕТСЯ ТОЛЬКО ЗАМЕНОЙ
НЕИСПРАВНЫХ НОСИТЕЛЕЙ ИЛИ ВОЗВРАЩЕНИЕМ ЗАКАЗЧИКУ УПЛАЧЕННЫХ СРЕДСТВ.

КОМПАНИЯ TEKTRONIX И ЕЕ ПОСТАВЩИКИ, ПРЕДОСТАВИВШИЕ ЕЙ ЛИЦЕНЗИОННЫЕ ПРАВА, НЕ НЕСУТ
ОТВЕТСТВЕННОСТИ ЗА КОСВЕННЫЙ, СПЕЦИФИЧЕСКИЙ, СЛУЧАЙНЫЙ ИЛИ КАКОЙ-ЛИБО ОПОСРЕДОВАННЫЙ
УЩЕРБ, ВЫЗВАННЫЙ ОБЛАДАНИЕМ ПРОГРАММОЙ ИЛИ ЕЕ ИСПОЛЬЗОВАНИЕМ ЗАКАЗЧИКОМ ДАЖЕ В ТОМ
СЛУЧАЕ, ЕСЛИ ПРЕДСТАВИТЕЛИ КОМПАНИИ TEKTRONIX БЫЛИ ЗАРАНЕЕ УВЕДОМЛЕНЫ О ВОЗМОЖНОСТИ
ТАКОГО УЩЕРБА.

ОГОВОРКА В ОТНОШЕНИИ ТРЕТЬИХ СТОРОН. Если явно не оговорено иное, третьи стороны, от которых компания
Tektronix получила право лицензирования, не предоставляют гарантию на Программу, не несут ответственности за ее
использование и не берут на себя обязательств предоставлять поддержку или сопроводительную информацию.

ОБЩИЕ ПОЛОЖЕНИЯ. Настоящее соглашение полностью оговаривает все взаимоотношения между сторонами
относительно использования, копирования и передачи Программы.

Ни это соглашение, ни лицензия, предоставляемая в его рамках, не могут быть переданы или переуступлены
Заказчиком без предварительного письменного согласия компании Tektronix.

Настоящее соглашение и лицензия, предоставляемая в его рамках, регулируются законами штата Орегон, США.

Все вопросы относительно этого соглашения или лицензии, предоставляемой в его рамках, следует решать в
ближайших торговых представительствах компании Tektronix.

ДОПОЛНИТЕЛЬНАЯ ЛИЦЕНЗИЯ ДЛЯ ТЕСТОВЫХ ВИДЕОМАТЕРИАЛОВ. Программный продукт может включать
определенные испытательные модели, тестовые видеоряды и видеоклипы, объединенные вместе под названием
«Тестовые видеоматериалы». В этом случае права заказчика на Тестовые видеоматериалы оговорены в
нижеприведенных пунктах:

Заказчик имеет право использовать, копировать и изменять Тестовые видеоматериалы, показывать или распространять
копии отдельных Тестовых видеоматериалов в рамках своей деятельности по тестированию видеооборудования.

Действия, не допустимые в рамках данной лицензии, перечислены ниже.

1. Заказчик не имеет права распространять коллекцию Тестовых видеоматериалов, кроме случаев, связанных с
продажей оригинального оборудования, содержащего Тестовые видеоматериалы, без предварительного
письменного разрешения от компании Tektronix.

2. Заказчик не имеет права разрешать третьим сторонам распространять копии Тестовых видеоматериалов.

3. Заказчик не имеет права продавать, лицензировать или распространять копии Тестовых видеоматериалов ни
отдельно, ни в составе какой-либо коллекции, продукта или услуги, где основную ценность продукта или услуги
составляют Тестовые видеоматериалы.

Заказчик должен возместить убытки, обезопасить и защитить интересы компании Tektronix в отношении любых
требований или судебных исков и расходов, включая оплату юридических услуг, которые являются результатом
использования или распространения Тестовых видеоматериалов в измененной форме.

Заказчик должен включить действительное уведомление об авторском праве в свои продукты и услуги, в которых
используются копии Тестовых видеоматериалов.
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Важная информация по безопасности
Настоящее руководство содержит информацию и предостережения, которые следует учитывать пользователю, чтобы
обеспечить безопасную эксплуатацию прибора и поддерживать его в безопасном состоянии.

Для безопасного выполнения обслуживания прибора изучите Правила техники безопасности при обслуживании,
которые следуют за разделом Общие правила техники безопасности.

Общие правила техники безопасности
Используйте изделие только описанным способом. Во избежание травм, а также повреждений данного прибора и
подключаемого к нему оборудования необходимо соблюдать следующие правила техники безопасности. Внимательно
прочтите все инструкции. Сохраните это руководство для использования в будущем.

Соблюдайте все местные и общегосударственные нормы безопасности.

Для правильной и безопасной эксплуатации изделия важно помимо изложенных в этом руководстве указаний выполнять
также общепринятые процедуры безопасности.

Изделие предназначено для использования только обученным персоналом.

Снимать крышку для ремонта, технического обслуживания или регулировки разрешается только квалифицированному
персоналу.

Для обеспечения правильной работы прибора перед использованием проверяйте его с помощью известного источника.

Этот прибор не предназначен для обнаружения опасных напряжений.

При работе вблизи опасных оголенных проводов под напряжением пользуйтесь средствами индивидуальной защиты
для предотвращения поражения электрическим током или дуговым разрядом.

При использовании этого прибора может потребоваться доступ к другим частям системы. Прочтите разделы по технике
безопасности в руководствах по работе с другими компонентами и ознакомьтесь с мерами предосторожности и
предупреждениями, связанными с эксплуатацией системы.

При встраивании этого оборудования в систему, ответственность за безопасность такой системы несет ее сборщик.

Пожарная безопасность и предотвращение травм
Используйте соответствующий шнур питания. Подключение к электросети следует выполнять только с помощью
кабеля, разрешенного к использованию с данным изделием и сертифицированным для страны, в которой будет
осуществляться его эксплуатация. Не используйте поставляемый в комплекте шнур питания с другими приборами.

Заземляйте прибор. Прибор заземляется через провод заземления шнура питания. Во избежание поражения
электрическим током провод заземления должен быть подключен к шине заземления. Проверьте наличие защитного
заземления, прежде чем выполнять подсоединение к выходам и входам прибора. Не отсоединяйте защитное
заземление кабеля питания.

Отключение питания. Выключатель питания отсоединяет прибор от источника питания. Размещение выключателя см.
в инструкции. Устанавливайте прибор таким образом, чтобы обеспечить доступ к выключателю питания для быстрого
отсоединения в любое время.

Проверяйте допустимые номиналы для всех разъемов. Во избежание воспламенения или поражения электрическим
током проверьте все допустимые номиналы и маркировку на приборе. Перед подсоединением прибора просмотрите
дополнительные сведения по номинальным ограничениям, содержащиеся в руководстве по эксплуатации прибора.

Не подавайте на разъемы, в том числе на разъем общего провода, напряжение, превышающее допустимое для данного
прибора номинальное значение.
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Измерительные клеммы не предназначены для подключения к электросети и цепям категорий II, III или IV.

Не используйте прибор со снятым кожухом. Эксплуатация прибора с открытым кожухом или снятыми защитными
панелями не допускается. Можно попасть под действие опасного напряжения.

Не прикасайтесь к оголенным участкам цепи. Не прикасайтесь к неизолированным соединениям и компонентам,
находящимся под напряжением.

Не пользуйтесь неисправным прибором. Если имеется подозрение, что прибор поврежден, передайте его для
осмотра специалисту по техническому обслуживанию.

Отключите прибор в случае его повреждения. Не пользуйтесь прибором, если он поврежден или работает неправильно.
В случае сомнений относительно безопасности прибора выключите его и отсоедините шнур питания. Четко обозначьте
прибор для предотвращения дальнейшей эксплуатации.

Перед использованием осмотрите прибор. Проверьте, нет ли на нем трещин и не отсутствуют ли какие-либо детали.

Используйте только рекомендованные запасные части.

Используйте соответствующий плавкий предохранитель. К применению допускаются только предохранители, типы
и номиналы которых соответствуют требованиям для данного прибора.

Пользуйтесь средствами для защиты зрения. При наличии интенсивных световых потоков или лазерного излучения
используйте средства для защиты зрения.

Не пользуйтесь прибором в условиях повышенной влажности. При перемещении прибора из холодного в теплое
помещение возможна конденсация.

Не пользуйтесь прибором во взрывоопасных средах.

Не допускайте попадания влаги и загрязнений на поверхность прибора. Перед чисткой прибора отключите все
входные сигналы.

Обеспечьте надлежащую вентиляцию. Дополнительные сведения по обеспечению надлежащей вентиляции при
установке изделия содержатся в руководстве.

Не закрывайте отверстия и щели, предназначенные для вентиляции. Не вставляйте какие-либо предметы в отверстия.

Обеспечьте безопасные рабочие условия. Устанавливайте прибор таким образом, чтобы было удобно просматривать
дисплей и индикаторы.

Избегайте неправильного или продолжительного использования клавиатур, указателей и кнопочных панелей.
Неправильное или продолжительное использование клавиатуры или указателя может привести к серьезной травме.

Обеспечьте соответствие рабочей зоны эргономическим стандартам. Для предотвращения туннельного синдрома
проконсультируйтесь со специалистом по эргономике.

Соблюдайте осторожность при подъеме и переноске изделия. Прибор снабжен ручками для подъема и переноски.
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Правила по технике безопасности при сервисном обслуживании
Раздел Правила по технике безопасности при сервисном обслуживании содержит дополнительную информацию о
безопасном обслуживании прибора. К обслуживанию устройства должен допускаться только квалифицированный
персонал. Прежде чем выполнять какие-либо процедуры по обслуживанию, ознакомьтесь с Правилами по технике
безопасности при сервисном обслуживании и Общими правилами техники безопасности.

Во избежание поражения электрическим током. Не прикасайтесь к оголенным контактам разъемов.

Не выполняйте операции по обслуживанию в одиночку. При обслуживании или настройке внутренних частей
прибора рядом должен находиться человек, способный оказать первую помощь и выполнить реанимационные
мероприятия.

Отсоедините питание. Во избежание поражения электрическим током перед снятием крышек и кожухов для
обслуживания выключайте прибор и отсоединяйте его от сети.

При обслуживании прибора с включенным питанием примите необходимые меры предосторожности. В приборе
могут присутствовать опасные напряжения и токи. Прежде чем снимать защитные панели, производить пайку или
замену компонентов, отключите питание, извлеките батарею (при ее наличии) и отсоедините испытательные выводы.

Проверьте безопасность после ремонта. После ремонта всегда проверяйте целостность заземления и
диэлектрическую прочность.

Условные обозначения в данном руководстве
Условные обозначения в данном руководстве:

ПРЕДУПРЕЖДЕНИЕ. Предупреждения о действиях и условиях, представляющих угрозу для жизни или способных
нанести вред здоровью.

ОСТОРОЖНО. Предостережения о действиях и условиях, способных привести к повреждению данного прибора или
другого оборудования.

Обозначения на изделии
Ниже приводится список символов на изделии.

■ Обозначение DANGER (ОПАСНО!) указывает на непосредственную опасность получения травмы.

■ Обозначение WARNING (ВНИМАНИЕ!) указывает на возможность получения травмы при отсутствии
непосредственной опасности.

■ Обозначение CAUTION (ОСТОРОЖНО!) указывает на возможность повреждения данного прибора и другого
имущества.

 Важная информация по безопасности
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Символы, встречающиеся на приборе

Если этот символ нанесен на изделие, обратитесь к руководству для выяснения характера потенциальной
опасности и мер по ее предотвращению. (Этот символ может также использоваться для указания на
номинальные значения в руководстве.)

Ниже приводится список символов на изделии.

 

Важная информация по безопасности  

xii Краткое руководство по эксплуатации систем MTS4000 и MTS4SAV3 с заводскими номерами B020101 и последующими



Информация о соответствии
В этом разделе приводится перечень стандартов по электромагнитной совместимости (ЭМС), безопасности и охране
окружающей среды, требованиям которых соответствует настоящий прибор.

Соответствие требованиям по ЭМС
Декларация о соответствии стандартам EC по электромагнитной совместимости
Отвечает требованиям директивы 2004/108/EC по электромагнитной совместимости. Проверено на соответствие
перечисленным ниже стандартам (как указано в Official Journal of the European Communities):

EN 61326-1. Требования по электромагнитной совместимости для контрольно-измерительного и лабораторного
электрооборудования.  1 2 3

■ CISPR 11. Обычные и наведенные излучения, группа 1, класс A.

■ IEC 61000-4-2. Защищенность от электростатических разрядов

■ IEC 61000-4-3. Защищенность от высокочастотных полей  4

■ IEC 61000-4-4. Защищенность от перепадов и всплесков напряжения

■ IEC 61000-4-5. Защищенность от скачков напряжения в сети питания

■ IEC 61000-4-6. Защищенность от наведенных радиочастотных помех

■ IEC 61000-4-11. Защищенность от понижения и пропадания напряжения в сети питания

ГОСТ 30804.3.2―2013 (IEC 61000‑3‑2:2009, EN 61000-3-2). Эмиссия гармонических составляющих тока

EN 61000-3-3. Изменения напряжения, флуктуации и фликер-шум

Код Контактная информация по нормативам произв..
Tektronix, Inc. PO Box 500, MS 19‐045
Beaverton, OR 97077, USA
ru.tek.com

1 Прибор предназначен для использования только в нежилых помещениях. При использовании в жилых помещениях прибор может создавать
электромагнитные помехи.

2 При подключении оборудования к тестируемому объекту могут возникать излучения, уровень которых превышает установленные указанным стандартом
значения.

3 Для обеспечения соответствия требованиям перечисленных стандартов по электромагнитной совместимости следует использовать качественные
экранированные интерфейсные кабели.

4 Система MTS4000 соответствует требованиям перечисленных выше гармонизированных стандартов в случае комплектования любыми интерфейсными
платами, кроме дополнительной платы QB2 (QAM, приложение B). Конкретные условия устойчивости к воздействию электромагнитных полей
радиочастотного диапазона применяются с данным дополнением, как указано ниже. При детектировании созвездия сигналов с модуляцией QAM-256 плата
QAM (приложение B) может оказаться чувствительной к излучаемым электромагнитным полям с уровнями ниже указанных в Таблице 1 ГОСТ Р МЭК 61326-1
—2014 для условий базовой электромагнитной обстановки по ГОСТ 30804.4.3—2013 (IEC 61000-4-3:2006). Это может проявляться в весьма узкой полосе
частот диапазона 44 МГц (частота местного гетеродина приемника QAM) на более высокой частоте, чем та, на которую настроен приемник. Из-за высокой
чувствительности демодулятора QAM в этом режиме захват сигнала передатчика может быть потерян, либо могут возникать ошибки в потоке данных. Для
получения наилучших характеристик подключение системы MTS4000 следует выполнять с использованием только качественных экранированных кабелей и
избегать использования переходников.
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Декларация о соответствии стандартам Австралии и Новой Зеландии по ЭМС
Соответствует следующему стандарту электромагнитной совместимости для радиокоммуникаций в соответствии с
ACMA:

■ CISPR 11. Обычные и наведенные излучения, группа 1, класс A, в соответствии с EN 61326-1.

Соответствие требованиям техники безопасности
В этом разделе перечислены стандарты безопасности, которым соответствует прибор, а также другая информация по
безопасности.

Декларация о соответствии стандартам EC для низковольтного оборудования
Проверено на соответствие следующему стандарту (Official Journal of the European Union).

Директива 2006/95/EC по низковольтному оборудованию.

■ EN 61010-1. Требования по безопасности контрольно-измерительного и лабораторного электрооборудования, часть
1: Общие требования.

Перечень аккредитованных на национальном уровне испытательных лабораторий США
■ UL 61010-1. Безопасность электрического оборудования для измерения, управления и лабораторного применения,

часть 1: Общие требования.

Сертификация в Канаде
■ CAN/CSA-C22.2 No. 61010-1. Требования по безопасности контрольно-измерительного и лабораторного

электрооборудования, часть 1: Общие требования.

Соответствие дополнительным стандартам
■ IEC 61010-1. Безопасность электрического оборудования для измерения, управления и лабораторного применения,

часть 1: Общие требования.

Тип оборудования
Тестовое и измерительное оборудование.

Класс безопасности
Класс 1 — заземленный прибор.

Описания степени загрязнения
Степень загрязнения, возможного вблизи прибора и внутри него. Обычно считается, что параметры среды внутри
прибора те же, что и снаружи. Прибор должен использоваться только в среде, параметры которой подходят для его
эксплуатации.

■ Уровень загрязнения 1. Загрязнение отсутствует, или имеет место только сухое, непроводящее загрязнение.
Приборы данной категории обычно заключены в герметичную оболочку или устанавливаются в чистых помещениях.

■ Уровень загрязнения 2. Обычно встречается загрязнение только сухими непроводящими материалами. Иногда
может наблюдаться временная проводимость, вызванная конденсацией. Такие условия типичны для жилых и
рабочих помещений. Временная конденсация наблюдается только в тех случаях, когда прибор не работает.

Информация о соответствии  
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■ Уровень загрязнения 3. Загрязнение проводящими материалами или сухими непроводящими материалами, которые
становятся проводящими из-за конденсации. Это характерно для закрытых помещений, в которых не ведется
контроль температуры и влажности. Место защищено от прямых солнечных лучей, дождя и ветра.

■ Уровень загрязнения 4. Загрязнение, приводящее к дополнительной проводимости из-за проводящей пыли, дождя
или снега. Типичные условия вне помещения.

Степень загрязнения
Уровень загрязнения 2 (по ГОСТ IEC 61010-1—2014). Примечание: прибор рассчитан на использование исключительно в
сухих помещениях.

Степень защиты IP
IP20 по ГОСТ 14254—2015 (IЕС 60529:2013), стандарт вводится в действие с 01.03.2017.

Описание категорий измерения и перенапряжения
Измерительные клеммы данного прибора могут использоваться для измерения сетевого напряжения одной или
нескольких из перечисленных ниже категорий (см. номинальные значения, указанные на приборе и в руководстве).

■ Категория измерения II. Для измерений, выполняемых в цепях, непосредственно подключенных к низковольтному
оборудованию.

■ Категория измерения III. Для измерений в установках, расположенных внутри здания.

■ Категория измерения IV. Для измерений низковольтных установок.

NOTE. Только цепи сетевого питания имеют категорию перенапряжения. Категорию измерения имеют только
измерительные цепи. Другие цепи прибора не имеют категорий.

Категория перенапряжения сети
Категория перенапряжения II (по ГОСТ IEC 61010-1—2014)

Соответствие требованиям по защите окружающей среды
В этом разделе содержатся сведения о влиянии прибора на окружающую среду.

Утилизация прибора по окончании срока службы
При утилизации прибора и его компонентов необходимо соблюдать приведенные ниже правила.

Утилизация оборудования. При изготовлении этого прибора использовались природные ресурсы. Прибор может
содержать вещества, опасные для окружающей среды и здоровья людей в случае его неправильной утилизации по
окончании срока службы. Во избежание попадания подобных веществ в окружающую среду и для сокращения расхода
природных ресурсов рекомендуется утилизировать данный прибор таким образом, чтобы обеспечить максимально
полное повторное использование его материалов.

Этот символ означает, что данный прибор соответствует требованиям Европейского союза, приведенным
в директивах 2012/19/EU и 2006/66/EC об утилизации электрического и электронного оборудования
(WEEE) и элементов питания. Информация о возможных способах утилизации приведена на веб-сайте
компании Tektronix (www.tek.com/productrecycling).

 Информация о соответствии
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Предисловие
В настоящем руководстве приводится описание функций и порядка использования систем тестирования Tektronix
MTS4000 MPEG с заводскими номерами B020101 и последующими. В настоящем руководстве используются следующие
правила именования приборов:

■ Прибор MTS4000 — для информации, применимой только к прибору MTS4000
■ Система MTS4000 — для информации, применимой к приборам MTS4000 и MTS4SAV3
■ Автономная система MTS4SAV3 — для информации, применимой только к прибору MTS4SAV3

Основные функции
■ Наиболее быстродействующая в отрасли система анализа позволяет сократить затраты времени на ознакомление,

быстрое расширение, оценку, развертывание и диагностику систем электросвязи и подготовку к предоставлению
услуг цифрового вещательного телевидения и телевизионного вещания по сети Интернет (IPTV) следующего
поколения.

■ Приборы позволяют работать с большим числом вариантов кодирования в соответствии со стандартами цифрового
вещательного телевидения, включая MPEG, DVB, ATSC, ISDB и ISDB-TB (Бразилия), со специальными стандартами
для наземного, кабельного и спутникового телевидения, а также региональными модификациями этих стандартов. 

■ Набор интерфейсов и аналитических функций обеспечивают возможность осуществления необходимых
подключений для диагностики проблем в любой точке сети, будь то каналы передачи (радиочастотные или на
уровне IP) или обработка передаваемого контента (уровень транспортного потока данных).

■ Системы можно подключать к сетям с использованием протоколов IP версий 4 и 6, в том числе, с поддержкой
широковещательных протоколов IGMP и MLD.

■ Анализ потоков с постоянной битовой скоростью передачи (режимы CBR и VBR  1).

■ Комплексный совместный анализ ошибок на различных уровнях протокола передачи и их регистрация — это
законченное полнофункциональное решение для диагностики проблем и сокращения времени анализа при поиске и
устранении неисправностей.

■ Функция воспроизведения имеет возможности изменения параметров и мультисессионной IP-репликации для
оценки характеристик поведения сети или испытуемого устройства.

■ Технология CaptureVu® позволяет регистрировать и анализировать системные события в реальном и замедленном
масштабах времени для устранения перемежающихся и комплексных неисправностей.

■ Формируемый средствами программного обеспечения инновационный интерфейс пользователя предоставляет
мощные инструменты опытного пользователя даже новичку.

■ Прикладные модули для анализа содержимого буфера протоколов H.265 (HEVC) и H.264, мультиплексирования и
проверки соответствия элементарного потока предоставляют наиболее мощный набор инструментов для создания
и анализа транспортных потоков данных с контентом, сформированным с использованием протоколов H.
265 (HEVC) и H.264.

■ Анализ качества потоков передачи звука и видео позволяет различать потери качества, возникающие при
распределении потоков по сети и в процессе сжатия данных.

■ Мониторинг состояния нескольких входов.

■ Возможность использования аналитического программного обеспечения на нескольких ЭВМ в единой сети (с
дополнительным модулем FLT).

1 Некоторые связанные с синхронизацией измерения невозможны в режиме VBR.
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Документация
Настоящее руководство содержит описания процесса установки и основ эксплуатации системы MTS4000. Для этого
изделия также имеются следующие документы:

Документ Назначение Местонахождение
MTS4000 и MTS4SAV3. Система
тестирования MPEG. Краткое руководство
по эксплуатации (071-2970-xx — на
английском, 077-0665-xx — на
упрощенном китайском, 077-0666-xx — на
японском, 077-0657-xx — на русском
языках)

Содержит описание процессов установки
и подготовки к использованию
измерительных систем.

MTS4000 and MTS4SAV3 MPEG Test
Systems Analyzer Applications User Manual
(MTS4000 и MTS4SAV3. Система
тестирования MPEG. Руководство
пользователя по работе с модулями
анализа сигналов прикладного
программного обеспечения, 077-0622-xx)

Содержит описание использования
следующих модулей прикладного
программного обеспечения системы для
анализа сигналов: TSCA, PES Analyzer, T-
STD Buffer Analyzer и ES Analyzer.

MTS4000 and MTS4SAV3 MPEG Test
Systems Generator Applications User
Manual (MTS4000 и MTS4SAV3. Система
тестирования MPEG. Руководство
пользователя по работе с модулями
генерации сигналов прикладного
программного обеспечения, 077-0623-xx)

Содержит описание использования
следующих модулей прикладного
программного обеспечения системы для
генерации сигналов: Multiplexer, MPEG
Player, TS Editor, Make Seamless Wizard,
Transport Stream Cutter и Script Pad.

MTS4000 and MTS4SAV3 MPEG Test
Systems Carousel Applications User Manual
(Руководство пользователя систем
тестирования MTS4000 и MTS4SAV3 по
работе с модулями Carousel прикладного
программного обеспечения (077-0624-xx)

Содержит описание использования
модулей прикладного программного
обеспечения Carousel Analyzer и Carousel
Generator.

MTS4000 MPEG Test Systems
Specifications and Performance Verification
Technical Reference (MTS4000. Система
тестирования MPEG. Справочное
руководство по техническим
характеристикам и проверке
эксплуатационных параметров, 077-0626-
xx)

Содержит перечень технических
характеристик и описание процедур
контроля.

MTS4000 / MTS4SAV3 MPEG Test Systems
Release Notes (MTS4000 / MTS4SAV3.
Система тестирования MPEG.
Примечания к выпуску MTS4000,
077-0627-xx)

Содержит описание обнаруженных в
системах тестирования ошибок.
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Документ Назначение Местонахождение
MTS4EAV7 HEVC / AVC Video and
Compressed Audio Analyzer User Manual
(Руководство пользователя приложения
MTS4EAV7 HEVC / AVC — Анализатор
видео и сжатого звукового сигнала HEVC/
AVC, 077-1134-xx)

Содержит описание использования
модуля MTS4EAV7 прикладного
программного обеспечения.

MTS4CC Elementary Stream Compliance
Checker User Manual (Руководство
пользователя приложения MTS4CC для
проверки соответствия элементарного
потока, 071-2075-xx)

Содержит описание использования
модуля MTS4CC прикладного
программного обеспечения.

PQA600C and PQASW Picture Quality
Analyzer User Manual (Руководство
пользователя приложений PQA600C и
PQASW анализа качества изображений,
077-1137-xx)

Содержит описание использования
модулей прикладного программного
обеспечения для анализа качества
изображения.

VQS1000 Video Quality Software Quick Start
User Manual (Краткое руководство
пользователя по работе с модулями
VQS1000 программного обеспечения для
контроля качества видеосигнала,
077-0489-xx)

Содержит описание использования
модуля VQS1000 прикладного
программного обеспечения.

Документацию для пользователей можно загрузить с веб-сайта Tektronix: www.tek.com/downloads.

Ниже перечислены URL-адреса веб-сайтов организаций по стандартизации (перечисленные адреса были
действительны во время подготовки настоящего руководства):

■ Стандарты MPEG-2 (Международная организация по стандартизации) —www.iso.org/

■ Стандарты DVB (Европейский институт технических стандартов) —www.etsi.org/

■ Стандарты ATSC (Комитет систем перспективного телевидения) —www.atsc.org/

Применение обозначений в данном руководстве
В данном руководстве по эксплуатации используются следующие символические обозначения.

Цифрами
обозначена
последовательн
ость действий

Выключатель
питания на
передней
панели

Подключение
электропитания

Сеть PS2 SVGA USB

 Предисловие
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Установка
Информация об установке поделена на разделы в соответствии с видом установки:

■ Аппаратные средства системы MTS4000. В этом разделе приводится описание установки аппаратных средств
системы MTS4000, порядок использования органов управления и соединителей, включения и выключения прибора
и подключения прибора к локальной сети Ethernet. (См. Установка оборудования системы MTS4000 на
странице 1).

■ Установка системы для работы с плавающей лицензией (только с дополнительным модулем FLT). В этом
разделе приводится описание процедуры установки и настройки конфигурации дополнительного модуля FLT,
который необходим для работы системы MTS4SA с плавающими лицензиями прикладных программ. (См. 
Установка системы для работы с плавающей лицензией (только с дополнительным модулем FLT) на
странице 11).

■ Установка автономной системы MTS4SAV3. В этом разделе приводится описание установки ПО автономных
систем MTS4SAV3. (См. Установка автономной системы MTS4SAV3 на странице 17). Если заказан
дополнительный модуль FLT, то перед установкой ПО MTS4SA необходимо установить системное ПО плавающих
лицензий.

■ Проигрыватель VLC Media Player. В этом разделе приводится описание загрузки и установки последней версии
проигрывателя VLC Media Player, с помощью которого можно просматривать видео в приложении Transport Stream
Compliance Analyzer (анализатор соответствия транспортного потока — TSCA). (См. Установка проигрывателя
VLC Media Player на странице 25).

Установка оборудования системы MTS4000
В настоящем разделе приводится описание установки оборудования системы MTS4000 и подключения системы к
локальной вычислительной сети.

Перед установкой
После получения прибора выполните описанную ниже процедуру осмотра.

1. Проверьте отсутствие внешних повреждений упаковки, которые могут указывать на возможные повреждения
прибора.

2. Извлеките прибор серии MTS4000 из упаковочной коробки.

3. Убедитесь, что прибор не поврежден при транспортировке. На корпусе не должно быть царапин или вмятин. Перед
отправкой приборы тщательно проверяются на наличие механических дефектов.

ПРИМЕЧАНИЕ. Сохраните коробку и упаковочные материалы на случай повторной упаковки и отправки
прибора. См. Возвращение прибора для обслуживания на странице 84.

4. Убедитесь в наличии всех стандартных и заказанных дополнительных принадлежностей. См. принадлежности на
странице 71.
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Условия эксплуатации
В следующей таблице приведены эксплуатационные требования к системам серии MTS4000 в отношении
электрооборудования. Полные эксплуатационные требования к приборам серии MTS4000 в отношении
электрооборудования приведены в документе Спецификации и технический справочник по проверке
работоспособности для систем тестирования MPEG серии MTS4000.

Требование Технические характеристики
Рабочая температура От 5 до 40 °C
Высота над уровнем моря (в рабочем режиме) От 0 до 2 000 м
Рабочая влажность Относительная влажность от 20 % до 80 %, без

конденсации
Напряжение От 100 до 240 Вср.квадр. ±10 %, от 47 до 63 Гц (от 90 до

264 ВAC ср.квадр.)
Диапазон частот 50/60 Гц
Максимальное энергопотребление 220 Вт
Плавкий предохранитель Не подлежит замене потребителем. Обслуживается

квалифицированным техническим персоналом.

Элементы управления и разъемы
В данном разделе описаны элементы управления и разъемы системы MTS4000. Для использования функций анализа
(если они включены) настройка не требуется — достаточно только подключить электропитание и сохранить
транспортный поток информации на жестком диске прибора. Для функций мониторинга и анализа в режиме реального
времени кроме подачи питания требуется также подключение к внешнему транспортному потоку.

Настройка системы MTS4000 производится при помощи программных и аппаратных опций, приобретенных вместе с ней
в момент покупки. Возможности системы MTS4000 могут быть расширены с помощью пакетов обновления, которые
поставляются компанией Tektronix.

ОСТОРОЖНО. Чтобы предотвратить перегрев приборов, обеспечьте зазор не менее 5,1 см с задней и боковых
сторон корпусов прибора при размещении его на рабочем месте.

ОСТОРОЖНО. Не подавайте электропитание на прибор до тех пор, пока не будут выполнены все остальные
подключения.

Установка  
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Боковые соединители. На следующем рисунке и в таблице представлены системные соединители MTS4000.

ПРИМЕЧАНИЕ. Приборы MTS4000 с заводскими номерами после B030000 и заказанные без дополнения 10GS
поступают с графической платой, установленной в гнездо 1. Приборы, заказанные с дополнением 10GS, или с
заводскими номерами до B029999 поступают с графической платой, установленной в гнездо 5.

Приборы MTS4000-EU с заводскими номерами после B050103 и заказанные без дополнения 10GS поступают с
графической платой, установленной в гнездо 1. Приборы, заказанные с дополнением 10GS, или с заводскими
номерами до B050103 поступают с графической платой, установленной в гнездо 5.

В приборе на рисунке слева графическая плата установлена в гнезде 1, а в приборе на правом рисунке графическая
плата установлена в гнезде 5.

Обозначени
е на рисунке

Описание Обозначени
е на рисунке

Описание

1 Порт DVI основного дисплея (к главному ЖК-
монитору)
Порт DVI дополнительного дисплея  2 3

6 Соединители для подключения мыши и
клавиатуры типов PS/21

2 Линейный выход: подключен к
громкоговорителю главного модуля
Линейный вход: не задействован
Микрофон1

7 Соединители для дополнительных
интерфейсных плат

3 Хост-порты USB 8 Соединители типа RJ-45 плат сетевых
интерфейсов (NIC)

4 Соединители видеосигналов DVI, VGA: не
задействованы

9 Выключатель питания переменного тока

2 Проверка ЭМС с подключенными к этому порту кабелями не проводилась.
3 Подключенный к дополнительному порту дисплей можно использовать для отображения или увеличения изображения на экране системы MTS4000. Дисплей

должен быть подключен при вводе прибора в эксплуатацию.

 Установка
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Обозначени
е на рисунке

Описание Обозначени
е на рисунке

Описание

5 Последовательные порты COM 1 и COM 2 10 Вилка питания переменного тока
Убедитесь, что сетевой шнур питания
соответствует стандартам страны
использования.

Элементы управления и разъемы на передней панели. На следующем рисунке показаны разъемы и элементы
управления передней панели системы MTS4000.
 

 

Ссылка на
рисунке

Описание Ссылка на
рисунке

Описание

1 Индикатор питания Мигает в режиме
ожидания.

5 Кнопка On/Standby (Включение/ожидание)

2 Индикатор активности жесткого диска. 6 Элементы управления ЖК-экраном
3 Кнопка Вкл./выкл. дисплея 7 Хост-порты USB
4 Кнопка перезагрузки (с низким профилем) 8 Разъем клавиатуры/мыши

Установка  
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Соединители для дополнительных плат. В систему MTS4000 можно добавить дополнительные платы для работы с
различными транспортными потоками, сетями и периферийными устройствами. В этом разделе приводится описание
доступных дополнительных плат и соединителей для подключения этих плат.

За подробными сведениями о каждом соединителе и о форматах входных/выходных сигналов каждой дополнительной
платы следует обращаться к MTS4000 MPEG Test System Specifications and Performance Verification Technical Reference
(Справочному руководству по техническим характеристикам и проверке эксплуатационных параметров систем
тестирования MPEG MTS4000).

ПРИМЕЧАНИЕ. В приборе может быть установлено до четырех плат расширения, но не более двух плат
следующих типов: DS2, VS, QB2, IPTV.

Убедитесь, что программный защитный ключ USB установлен в один из портов USB.

ПРИМЕЧАНИЕ. Системные приложения MTS4000 и установленные дополнительные платы не будут работать без
установленного программного защитного ключа.

При возврате системы тестирования в сервисный центр Tektronix для модернизации или ремонта следует также
предоставить защитный программный ключ.

Таблица 1: Дополнительные платы и соединители

Многопортовый интерфейс ASI (дополнение
ASI)
Соединители: BNC, 75 Ом

Интерфейс DVB-S/S2 с двумя входами
(дополнение DS2)
Обеспечивает демодуляцию DVB-S QPSK и DVB-
S2 QPSK, 8PSK, 16APSK, а также 32APSK

Интерфейс DVB-S/S2 с одним входом
(дополнение S2)
Обеспечивает демодуляцию DVB-S QPSK и DVB-
S2 QPSK, 8PSK, 16APSK, а также 32APSK
(требуется дополнение ASI)

ПРИМЕЧАНИЕ. Поставка дополнительных
плат S2 прекращена, заменена
дополнительной платой DS2, вид которой
показан выше.

 Установка
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Интерфейс 8VSB (дополнение VS)
Соответствует требованиям стандарта ATSC A/
53B
(требуется дополнение ASI)

ПРИМЕЧАНИЕ. Поставка дополнительных
плат VS прекращена.

Интерфейс QAM B (дополнение QB2)
Интерфейс 64QAM, 256QAM
(требуется дополнение ASI)

ПРИМЕЧАНИЕ. Поставка дополнительных
плат QB2 прекращена.

Сетевой интерфейс с двойным оптическим
портом 10GBase-SR 10 Гбит/с (дополнение
10GS)
Включает приемо-передающее устройство SFP
для работы с оптическими линиями малой
протяженности (850 нм) и модули ПО

ПРИМЕЧАНИЕ. При заказе новых приборов
аппаратное дополнение 10GS доступно только
при приобретении и не может быть
установлено при модернизации после покупки.

Комплект для модернизации аппаратных
средств 10GS доступен только для приборов
MTS4000 с заводскими номерами B029999 и
предшествующими и недоступен для приборов
MTS4000-EU с заводскими номерами B050103 и
предшествующими.

Телевизионный интерфейс IP Video
(дополнение IPTV)
Интерфейс IPTV Gigabit Ethernet с электрическим
портом 10/100/1000Base-T с соединителем RJ45
(требуется дополнение ASI)

ПРИМЕЧАНИЕ. Дополнительная плата IPTV
недоступна для приборов MTS4000-EU.

Установка  
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Приемо-передающие модули SFP
(дополнения SX, LX, ZX):
— Коротковолновый оптический порт 1000Base-
SX с соединителем LC для интерфейса IPTV
Ethernet (многомодовый, 850 нм);
- Длинноволновый оптический порт 1000Base-LX
с соединителем LC для интерфейса IPTV
Ethernet (многомодовый, 1310 нм);
— Оптический порт 1000Base-ZX с соединителем
LC для интерфейса IPTV Ethernet (одномодовый,
1550 нм).

ОСТОРОЖНО.

Когда оптический порт приемо-передающего
модуля SFP не используется, его следует
закрывать заглушкой.

Во избежание воздействия опасного лазерного
излучения следует использовать только
лазеры Класса 1 как определено федеральными
нормами США CDRH 21 CFR 1040 и ГОСТ IEC
60825-2-2013 (IEC/EN 60825/A2:2001).

Включение прибора
Подача питания. Система MTS4000 рассчитана на работу от однофазной электрической сети с одним проводником
тока, имеющим потенциал, близкий к потенциалу заземления (нейтрали) или равный ему. Не рекомендуется
использовать в качестве источников электропитания системы, где оба проводника тока находятся под напряжением
относительно заземления (такие как «фаза — фаза» в многофазных системах). Для безопасной работы прибора
необходимо использовать защитное заземление по проводу заземления кабеля питания.

После установки системы MTS4000 и подсоединения всех сигнальных и периферийных цепей подключите шнур питания
к сети электропитания. 

 Установка
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При включении питания. Включите питание системы тестирования в следующем порядке:

1. Переместите фиксаторы клавиатуры
вверх.

2. Откиньте секцию клавиатуры.

3. Включите питание прибора
переключателем On/Standby
(Включение/ожидание),
расположенным на передней панели.

ПРИМЕЧАНИЕ. Убедитесь, что
основной выключатель питания на
задней панели включен.

 

Дождитесь завершения самопроверки
прибора при включении. 

Имя пользователя по умолчанию —
MTS с паролем. 

ПРИМЕЧАНИЕ. Инструкции по
настройке учетных записей
пользователей и паролей см. в
справке Windows.

 

Установка  

8 Краткое руководство по эксплуатации систем MTS4000 и MTS4SAV3 с заводскими номерами B020101 и последующими



Отсоединение клавиатуры. 

1. Передвиньте выступы клавиатуры к
центру.

2. Выдвиньте клавиатуру из корпуса
MTS4000.

Выключение прибора
Нажмите и отпустите кнопку передней панели On/Standby (Включение/ожидание). Система выключится автоматически
без дополнительного вмешательства.

Также вы можете отключить прибор, используя процедуру завершения работы Windows 7. Нажмите Start > Shut down...
(Пуск > Завершение работы...). При этом система (включая приложения) выключится автоматически.

Если прибор перестанет отвечать, нажмите и удерживайте кнопку On/Standby (Включение/ожидание) В течение пяти
секунд. При этом прибор будет принудительно отключен без завершение работы ОС Windows.

Установка сетевого подключения
Система MTS4000 может быть подключена к компьютерной сети. Подробные сведения о корректной конфигурации сети
можно получить у системного администратора. Сведения об установке и эксплуатации можно найти в документации,
поставляемой вместе с программным и аппаратным сетевым обеспечением.

Устранение неполадок c сетью. Сети основаны на стандартах; однако, есть много уникальных характеристик каждой
сети (локальной или глобальной), которые затрудняют поиск неисправностей, если выполнять его без полного знания
специфики сети. Следовательно, выполнить всесторонний поиск неисправностей сети должен эксперт, который знает
все ее характеристики.

В данном разделе содержатся общие методы, которые можно использовать для устранения наиболее
распространенных сетевых ошибок. Если эти методы не позволяют устранить проблемы, обратитесь за помощью к
администратору сети.

Основные требования. Перед проверкой главных компьютеров выполните следующие требования:

■ Настройте систему на использование в вашей сети. Подробности можно узнать у администратора сети. Сетевые
адаптеры систем MTS4000 настроены на использование автоадресации DHCP.

■ Удостоверьтесь, что любые приложения, которые, возможно, загружены в систему тестирования с момента ее
получения, не используют порты, предназначенные для компонентов системы тестирования.

Параметры IP-адреса. Иллюстрации этого раздела показывают, как каждый IP-параметр (IP-адрес, маска подсети, и
шлюз по умолчанию) может негативно воздействовать на подключение к сети.

Стандартные процедуры поиска неисправностей. Многие процедуры, рассматриваемые в следующих разделах,
предназначены для выполнения стандартных задач.
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Пределы полосы пропускания NIC. Платформа MTS4000 имеет две карты сетевого интерфейса (NIC) CAT5 для
анализа IP-сигналов. См. Боковые соединители на странице 3. Названия и полосы пропускания карт сетевых
интерфейсов немного различаются. Как показано ниже, просмотреть сетевые соединения можно меню в Control Panel
(Панель управления) > Network and Internet (Сеть и Интернет) > Network Connections (Сетевые соединения).
 

 

Верхняя сетевая карта. Верхняя сетевая карта содержит имя устройства Intel 82583V и обычно используется для
локальной сети и удаленного управления MS RDP. Полоса пропускания сигналов ввода-вывода этой карты составляет:

■ выходной сигнал проигрывателя MPEG до 80 Мбит/с;
■ входной сигнал TSCA IP до 400 Мбит/с.

Нижняя сетевая карта. Нижняя NIC сетевая карта содержит имя устройства Intel 82578DM и имеет следующие пределы
полосы пропускания сигналов ввода-вывода:

■ выходной сигнал проигрывателя MPEG до 250 Мбит/с;
■ входной сигнал TSCA IP до 600 Мбит/с.

Опция интерфейса 10GS. Карта опционального интерфейса 10GS (10 Гбит/с) содержит имя устройства Intel X520 и
имеет следующие пределы полосы пропускания сигналов ввода-вывода:

■ выходной сигнал проигрывателя MPEG до 300 Мбит/с;
■ входной сигнал TSCA IP до 600 Мбит/с.

ПРИМЕЧАНИЕ. Опциональная карта интерфейса IPTV не имеет ограничений полосы пропускания.
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Источники информации о сети. Ниже приведены некоторые ресурсы для получения дополнительной информации по
поиску и устранению неисправностей сети.

■ Cisco Systems, Inc. — http://www.cisco.com/

Этот веб-сайт особенно полезен для сетей, в которых используются устройства компании Cisco.

■ Dulaney, E; Lawrence, S; Scrimger, R; Tilke, A; White, J; Williams, R; Wolford, K. MCSE Training Guide: TCP/IP.
Indianapolis, IN. New Riders, 1998

Это обучающее руководство, предназначенное для аттестации системных инженеров Microsoft, посвящено
вопросам TCP/IP и устранению неисправностей сети.

■ Taylor, E. Network Troubleshooting Handbook. New York, NY. McGraw-Hill, 1999

ПРИМЕЧАНИЕ. Эти ресурсы позволят расширить ваши знания по этому вопросу. Большая часть этой информации
предоставлена «как есть»: без гарантии ее пригодности, явной или неявной. При поиске и устранении
неисправностей сети лучше всего обратиться за помощью к сетевому администратору.

Установка системы для работы с плавающей лицензией (только с
дополнительным модулем FLT)

Дополнительный модуль FLT обеспечивает работу в режиме плавающей лицензии, позволяющий использовать
аналитическое ПО MTS4000 на нескольких ПК, подключенных к локальной сети. Для работы с плавающей лицензией
необходимо, чтобы ПО сервера лицензий было установлено в системе MTS4000 или на подключенной к сети ЭВМ. 

ПРИМЕЧАНИЕ. Использующим систему MTS4000: установка ПО сервера лицензий в системе MTS4000 не
требуется. ПО сервера лицензий можно установить на любой ЭВМ в локальной сети.

При заказе дополнительного модуля FLT пакет ПО MTS4SA поставляется с плавающей лицензией, для работы которой
используется защитный ключ с программным ключом-лицензией, подключенный к серверу лицензий или локальной
ЭВМ. Иными словами, для выполнения ПО MTS4SA необходим программный ключ MTS4SA, установленный на ЭВМ или
на сервере, где это ПО выполняется.

ПРИМЕЧАНИЕ. Наличие программного ключа весьма важно, поскольку он содержит лицензию MTS4SA и несет в себе
стоимость изделия MTS4SA. При утрате защитного ключа потребуется приобрести новый ключ, стоимость
которого может соответствовать полной цене пакета ПО по прейскуранту.

После установки дополнительного модуля FLT в системе появляется не менее двух плавающих лицензий:

■ Одна лицензия исходной системы MTS4000 или MTS4SAV3
■ Хотя бы одна лицензия дополнительного модуля FLT

При заказе нескольких экземпляров дополнительного модуля FLT в системе появится соответствующее число
дополнительных лицензий.
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Требования к серверу плавающих лицензий
Обратите внимание на следующее системное требование к серверу плавающих лицензий:
■ Для установки защитного программного ключа необходимо иметь возможность подключения USB на удаленном

сервере или локальном ПК.
■ Если ПО сервера лицензий установлено на удаленном сервере, процесс сервера лицензий должен выполняться на

серверной ЭВМ (этот процесс создает незначительную нагрузку на центральный процессор).
■ Если ПО клиента установлено на удаленном сервере, то для его работы требуется доступ к серверу по протоколам

TCP/IP (это можно обеспечить с помощью виртуальной частной сети VPN, объединяющей удаленные узлы).

Процедура установки плавающей лицензии
Для установки системы с плавающей лицензией необходимо выполнить следующие действия:

1. Установить и настроить конфигурацию программного обеспечения DK2 Network Server сервера сети на серверной
ЭВМ или на платформе системы MTS4000. (См. Установка и настройка конфигурации ПО плавающей лицензии
на странице 12).

2. Установить программное обеспечение MTS4SA и ввести ключ дополнительных программных модулей на всех ЭВМ,
где планируется использовать ПО MTS4SA. (См. Установка автономной системы MTS4SAV3 на странице 17).

ПРИМЕЧАНИЕ. Для устойчивой работы системы следует обеспечить выполнение ПО MTS4SA одной и той же
версии (3.3 или более поздней) на всех ЭВМ.

3. Настроить конфигурацию ПО DK2 Network Client сетевого клиента на всех клиентских ЭВМ. (См. Настройка
конфигурации клиентского ПО плавающей лицензии на странице 14).

Установка и настройка конфигурации ПО плавающей лицензии
Дополнительный модуль ПО FLT сервера лицензий содержит ключ программного обеспечения для одной или большего
числа лицензий. В сети может быть несколько серверов лицензий, каждый со своим программным ключом, которые
совместно формируют пул лицензий для использования модулями клиентов. Несложно создать ЭВМ, выполняющую
одновременно функции сервера и клиента.

ПРИМЕЧАНИЕ. В системах MTS4000 ПО сервера лицензий при отгрузке с завода не устанавливается. Однако, ПО
сервера имеется на установочном компакт-диске MTS4000 and MTS4SAV3 Application Install CD вместе с программой
установки версии 3.3 или более поздней, его можно также загрузить с веб-сайта Tektronix.

Чтобы обеспечить выполнение функций сервера плавающей лицензии в системе MTS4000 или на серверной ЭВМ,
следует выполнить следующие действия:

1. Выберите ЭВМ, которую планируется использовать в качестве сервера, и подключите (к порту USB или к
параллельному порту в зависимости типа программного ключа) защитный ключ ПО, содержащий одну или большее
число плавающих лицензий.

2. Если ПО DESkey уже установлено, то его следует удалить.

ПРИМЕЧАНИЕ. Если ПО MTS4SA было установлено на серверной ЭВМ ранее, то ПО DESkey было установлено
вместе с ним. Рекомендуется удалить старую версию ПО DESkey, а затем установить новую.

a. Откройте Панель управления (Control Panel) на серверной ЭВМ (Windows Start (Пуск) > Settings (Настройки) >
Control Panel (Панель управления) и выберите значок Programs and Features (Программы и компоненты).

b. Выберите элемент DK2 DESkey Drivers (драйверы DK2 DESkey), затем нажмите кнопку Uninstall/Change
(Удалить/Заменить).

c. Нажмите кнопку Uninstall (Удалить) для удаления ПО.
d. После завершения процесса удаления закройте Control Panel (Панель управления).
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3. Установите новую версию ПО DESkey.

a. Поместите установочный компакт-диск MTS4000 and MTS4SAV3 Application Install CD (Установочный компакт-
диск приложений MTS4000 и MTS4SAV3) в соответствующий дисковод серверной ЭВМ.

b. После помещения компакт-диска в дисковод и появления на экране окна программы установки MTS4SA
нажмите кнопку Close (Закрыть) в нижней части окна для завершения работы программы установки MTS4SA.

c. С помощью утилиты «Проводник» (Explorer) ОС Windows отыщите папку DES на установочном компакт-диске и
откройте ее.

d. Запустите выполнение программы dnsrv32.exe. В процессе установки подтвердите использование
предлагаемых по умолчанию значений параметров.

e. Запустите выполнение программы dk2wn32.exe. В процессе установки подтвердите использование
предлагаемых по умолчанию значений параметров.

f. Если по завершении установки выводится сообщение о необходимости перезагрузки, следует выполнить
перезагрузку серверной ЭВМ.

4. Настройте конфигурацию сервера лицензий DESkey.

a. Откройте Панель управления (Control Panel) на серверной ЭВМ (Windows Start (Пуск) > Settings (Настройки) >
Control Panel (Панель управления) и выберите значок DESkey. Отобразится диалог настройки конфигурации
(выводимый в нижней части окна номер версии может меняться).

b. Выберите вкладку DK2 / DK38. Отметьте элементы, как указано ниже:

■ Поставьте флажок Enable Bi-Tronics Compatibility (Разрешить режим совместимости с Bi-Tronics).
■ Поставьте флажок Show Window on ECP Activity (Отображать окно при наличии сигнала на ECP).
■ Поставьте флажок Enable Local DK2 Access (Разрешить доступ к локальному DK2).
■ Поставьте флажок Enable Network DK2 Access (Разрешить доступ к сетевому DK2).
■ Убедитесь, что ручка настройки радио находится в положении Search Local First (Сперва искать местные).
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c. Выберите вкладку Networking (Сеть). В поле с меткой «Server Port Number» (Номер порта сервера) в нижней
части окна отображается номер порта, выделенного для связи с любыми другими клиентами, значение по
умолчанию — 3029. Нажмите кнопку OK для завершения.
 

 

5. Запишите адрес IP ЭВМ сервера плавающей лицензии. Этот адрес понадобится для настройки конфигурации
клиентских ЭВМ.

Если порт 3029 блокирован. В соответствии с установленной отделом информационных технологий политикой порт
3029 может оказаться блокированным брандмауэром сети. В этом случае следует проконсультироваться у
администратора сети об использовании иного, не подпадающего под ограничения, порта. После получения номера
разрешенного для использования порта следует выполнить следующие действия:

1. Во вкладке «Networking» (Сеть) введите новый номер порта и нажмите кнопку Apply (Применить).

2. Если выводится сообщение о необходимости повторного пуска ПО сервера, выберите Yes (Да). Это вызовет
остановку и повторный пуск сетевых служб на сервере с использованием порта с новым номером.

3. После задействования указанного порта нажмите кнопку OK для завершения.

ПРИМЕЧАНИЕ. Это не требует перезагрузки серверной ЭВМ, выполняется только повторный пуск сервера
лицензий.

Настройка конфигурации клиентского ПО плавающей лицензии
На каждой клиентской машине, которой требуется обеспечить доступ к ПО MTS4SA, следует выполнить следующие
действия по настройке конфигурации клиентского ПО плавающей лицензии.

ПРИМЕЧАНИЕ. Клиентское ПО плавающей лицензии устанавливается автоматически при установке ПО MTS4SA.

Необходимо ввести адрес IP серверной ЭВМ плавающих лицензий MTS4SA, выполнив последовательно указанные
ниже действия.
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Для настройки конфигурации клиентского ПО лицензии DESkey выполните следующие действия:

1. На клиентской ЭВМ откройте Панель управления (Control Panel, Windows Start (Пуск) > Settings (Настройки) > Control
Panel (Панель управления) и выберите значок DESkey. Отобразится диалог настройки конфигурации DESkey
(выводимый в нижней части окна номер версии может меняться).

2. Выберите вкладку DK2 / DK38. Выберите элементы, установив флажки как указано ниже:

■ Установите флажок Enable Bi-Tronics Compatibility (Разрешить совместимость с Bi-Tronics).
■ Установите флажок Show Window on ECP Activity (Отображать окно при наличии сигнала на ECP).
■ Установите флажок Enable Local DK2 Access (Разрешить доступ к локальному DK2).
■ Установите флажок Enable Network DK2 Access (Разрешить доступ к сетевому DK2).
■ Убедитесь, что ручка настройки радио находится в положении Search Network First (Сперва искать местные).
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3. Выберите вкладку Networking (Сеть). В списке назначенных для этой ЭВМ серверов (Destination Servers) должно
отображаться значение localhost, как показано ниже.
 

 

4. Нажмите кнопку Add (Добавить) для вывода диалогового окна Add DK2 Network Server (Добавить сетевой сервер
DK2).
 

 

5. Введите адрес IP серверной ЭВМ плавающих лицензий MTS4SA и нажмите OK. Введенный адрес IP появится в
списке назначенных серверов.
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6. В списке назначенных серверов выберите адрес IP сервера лицензий, как показано ниже (адрес IP будет выделен
подсветкой).
 

 

7. В поле «Server Port Number» (Номер порта сервера) в нижней части окна вкладки «Networking» (Сеть) отобразится
номер порта, назначенного для связи с любыми другими клиентами, значение по умолчанию — 3029.

8. Нажмите кнопку OK для завершения.

ПРИМЕЧАНИЕ. В соответствии с установленной отделом информационных технологий политикой порт
3029 может оказаться блокированным брандмауэром сети. В этом случае следует проконсультироваться у
администратора сети об использовании иного, не подпадающего под ограничения, порта. (См. Если порт
3029 блокирован на странице 14).

Установка автономной системы MTS4SAV3
Автономная система MTS4SAV3 позволяет использовать системные приложения MTS4000 на ПК.

В комплект MTS4SAV3 входит защитный USB-ключ программного обеспечения дополнений. После установки защитного
USB-ключа программного обеспечения дополнений открывается доступ к различным программным дополнениям
системы MTS4000. Состав хранящихся в защитном USB-ключе программных ключей дополнений определяется набором
приобретенных дополнительных программных модулей. Для открытия MTS4SAV3 необходимы как защитный USB-ключ,
так и защитные программные ключи дополнений.

При заказе дополнительного модуля ESB или модуля ESE (MTS4EAV7 — Анализатор видеосигнала и сжатого звукового
сигнала HEVC / AVC) или дополнения CA (MTS4EAV7 — Анализатор титров), следует выполнить процедуру установки,
описанную в Руководстве пользователя приложения MTS4EAV7 — Анализатор видеосигнала и сжатого
аудиосигнала HEVC/AVC.
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Требования к системе
Ниже приведена минимальная конфигурация ПК, необходимая для установки автономной системы MTS4SAV3:

■ 64-разрядная операционная система Microsoft Windows 7 или Windows 8.1 
■ Процессор с тактовой частотой >2,5 ГГц
■ Оперативная память не менее 4 ГБ
■ Разрешение дисплея не менее 1024 x 768 пикселов
■ Не менее 250 ГБ свободного пространства на жестком диске

Требования к системе для установки опций ESB, ESE и CA
Для установки опций ESB или ESE (MTS4EAV7 — Анализатор видеосигнала и сжатого аудиосигнала HEVC/AVC) или
опции CA (MTS4EAV7 — Анализатор титров) рекомендуется приведенная ниже минимальная конфигурация ПК. Более
подробные сведения см. в Руководстве пользователя MTS4EAV7.

■ 64-разрядная операционная система Microsoft Windows 7 или Windows 8.1 
■ Процессор с тактовой частотой >2,5 ГГц
■ Оперативная память не менее 4 ГБ
■ Не менее 250 ГБ свободного пространства на жестком диске

Установка  
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Установка программного обеспечения MTS4SA
1. Если защитный ключ программного

обеспечения MTS4000 USB
установлен, удалите электронный
ключ из порта USB ПК или сервера
плавающей лицензии (только с
дополнительным модулем FLT).

ОСТОРОЖНО. Во избежание проблем
при установке рекомендуется
удалить защитный ключ
программного обеспечения из USB-
порта ПК перед установкой
программного обеспечения.

2. Затем поместите компакт-диск для
установки прикладного ПО
MTS4000 and MTS4SAV3 Application
Install CD в привод DVD-накопителя
ПК.

Начинается выполнение программы
установки и выводится изображение
экрана приветствия. 

При некоторых вариантах настройки
конфигурации ОС Windows и служб
безопасности автоматический пуск
программы установки ПО MTS4000
может не происходить. 

При необходимости, следует
воспользоваться программой
«Проводник» (Explorer) ОС Windows,
чтобы отыскать файл
MTS4000_setup.exe на установочном
компакт-диске и инициировать
выполнение программы установки.
Выполните пуск программы щелчком
правой кнопки мыши и выбором
режима Запуск от имени
администратора. 

3. На экране приветствия программы
установки выберите Next (Далее).

 Установка
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4. Прочитайте лицензионное соглашение
конечного пользователя. Примите
условия соглашения и нажмите Next
(Далее).

5. В диалоговом окне Choose Setup Type
(Выбор вида установки) выберите
Install on Standalone PC (Установить
на автономно работающий ПК) для
установки ПО MTS4SAV3 на ПК.

6. Выберите Next (Далее).

Установка  
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7. В отображаемом окне «Ready to
Install» (Готов к установке) выберите
Install (Установить).

ПРИМЕЧАНИЕ. В процессе установки
на экран выводится ряд окон с
сообщениями. Обычно
вмешательство пользователя не
требуется.

Если при выполнении программы
установки обнаруживается более
ранняя версия ПО MTS4000, эта
версия будет автоматически
удалена.

 

8. Разрешите продолжить процесс
установки.

9. При отображении сообщения
программы установки DESkey
выберите Next (Далее) для перехода к
установке DESkey. При некоторых
вариантах настройки ОС Windows
может выводиться предупреждение
служб безопасности об установке ПО
устройства. Выберите Install
(Установить).

Если при выполнении установщика ПО
MTS4000 обнаруживается корректная
установленная версия ПО DESkey,
установка DESkey не выполняется. 

 Установка
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10. При появлении сообщения
установщика ПО WinPcap выберите
Next (Далее).

Разрешите продолжить процесс
установки ПО WinPcap. 

Если при выполнении программы
установки ПО MTS4000
обнаруживается корректная
установленная версия ПО WinPcap,
установка ПО WinPcap не
выполняется. 

11. По завершении процесса и выводе
сообщения об окончании установки
выберите Finish (Готово).

Прежде чем ввести ключ дополнения
или использовать приложения,
необходимо выполнить перезагрузку. 

Установка  
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12. После повторного пуска ПК следует
установить защитный ключ
программного обеспечения MTS4000
USB в порт USB местного ПК или
подтвердить, что защитный ключ
установлен и обнаружен удаленным
сервером (только с дополнительным
модулем FLT).

13. После того, как ПК обнаружит
защитный ключ программного
обеспечения, откройте MTS4000 Option
Key Wizard (Мастер ключа дополнений)
выбором Start (Пуск) > Programs
(Программы) > Tektronix MTS4000 >
OptionKey Wizard. (Мастер ключей
дополнений) (Мастер ключей
дополнений)

14. В диалоговом окне Tektronix Option
Update (Обновление дополнений
Tektronix) в поле Key String (Строка
ключа) введите строку ключа
дополнения (Option Key String),
имеующуюся в комплекте
документации по установке.

15. Нажмите кнопку Apply (Применить).

16. Проверьте список лицензий
дополнительных модулей. 

ПРИМЕЧАНИЕ. Доступ к функциям в
процессе работы управляется
лицензиями, содержащимися в
программном ключе. Приложения
могут быть установлены, но их
функции будут недоступны без
приобретения соответствующей
лицензии. Уведомление об этом
передается при покупке изделия или
дополнительных лицензий.

Лицензии для модулей MTS4EAV7 и
MTS4CC хранятся в защитном USB-
ключе программного обеспечения.
Для модулей VQS и PQA требуются
отдельные лицензии.

17. Закройте окно Option Key Wizard
(Мастер ключа дополнений).

 Установка
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18. Пуск всех работающих автономно
приложений инициируют из меню Start
(Пуск) > All Programs (Все программы)
> Tektronix MTS4SAV3 или с
использованием ярлыков в папке
рабочего стола: Real Time Analyzers
(Анализаторы в реальном времени),
Deferred Time Analyzers (Анализаторы
в замедленном времени), Generators
(Генераторы), Player (Проигрыватель)
или Utilities (Служебные программы).
(См. Запуск приложения на
странице 30).
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Установка проигрывателя VLC Media Player
Чтобы просматривать видеосигнал в приложении Transport Stream Compliance Analyzer (TSCA), необходимо загрузить
последнюю версию проигрывателя VLC Media Player с веб-сайта VideoLAN и установить ее.

1. Используя прибор MTS4000 или
компьютер с доступом к Интернету,
откройте домашнюю страницу веб-
сайта VideoLan (www.videolan.org).

2. Найдите и загрузите на жесткий диск
ПК самораспаковывающуюся
программу установки проигрывателя
VLC Media Player для Windows.
Рекомендуется использовать 32-
разрядную версию.

3. Найдите загруженный файл
проигрывателя VLC Media Player на
приборе и запустите его.

4. Выберите нужный язык. Появится
экран Welcome/Setup (Приветствие/
установка).

5. Установите проигрыватель VLC Media
Player, следуя инструкциям на экране.

Дополнительные действия не требуются. Проигрыватель VLC Media Player будет использоваться приложением TSCA по
мере необходимости.

 Установка
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Эксплуатация

Описание прибора
Система тестирования MPEG MTS4000 предоставляет полный интегрированный набор инструментов анализа,
работающих как в режиме реального времени, так и в отложенном режиме (офлайн). Эти инструменты включают
анализатор соответствия транспортного потока, анализатор буфера и анализаторы элементарных потоков видео и
аудио PES, MPEG2 и MPEG4. Также включены редактор и мультиплексор для создания потокового контента и
проведения испытаний содержащих ошибки потоков.

Приложения в наборе инструментальных средств MTS4000 предназначены для специфических элементов или слоев
транспортного потока. На следующем рисунке этот принцип иллюстрируется в наглядной форме.
 

 

В разделе «Процедура» описывается, как запустить приложение, как проанализировать тестовый поток и какие
результаты будут получены. Вместе с тем в процедурах не указано, как интерпретировать результаты.

Соответствие стандартам обеспечивается через встроенный настраиваемый сценарий, который поддерживает широкий
диапазон утвержденных и развивающихся стандартов DTV. Новые стандарты и частные таблицы могут легко быть
внедрены путем загрузки предоставляемых Tektronix обновлений или с помощью пользовательских сценариев.
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Программное обеспечение
Этот раздел содержит краткий обзор приложений, которые входят в состав системы тестирования MPEG MTS4000.
Обратите внимание, что некоторые опции могут быть отключены. Полные описания всех приложений приведены в
руководствах пользователя приложений системы тестирования MPEG MTS4000.

Приложение Значок  1

Анализаторы
Transport Stream Compliance Analyzer (TSCA) —
исследование транспортного потока в режиме
реального времени и в отложенном режиме с
возможностью выбора пользователем тестов
соответствия MPEG-2, DVB и ATSC. Отображает
транспортную структуру, содержимое заголовка,
содержимое шестнадцатеричного пакета, графики
синхронизации PCR/скорости транспортировки и
журналы сообщений об ошибках.

Первая карта RF/IP, установленная в систему
тестирования MTS4000, располагается над картой
ASI. Доступ к карте RF/IP осуществляется с
помощью значка TS Compliance Analyser,
расположенного в папке Real Time Analyzers на
рабочем столе и в меню «Пуск».
Вторая карта RF/IP, установленная в систему
тестирования MTS4000, располагается под картой
ASI. Доступ к этой карте RF/IP осуществляется с
помощью значка TS Compliance Analyser P1,
расположенного в папке Real Time Analyzers на
рабочем столе. (В меню Start (Пуск) значок TSCA
P1 отсутствует.)

Packetized Elementary Stream (PES) Analyzer — анализ пакетированного элементарного потока (PES)
с выбираемыми тестовыми опциями. Отображает структуру программы PES, содержимое заголовка,
содержимое пакета, временные графики PTS/DTS и отчеты анализа.

Transport Stream — System Target Decoder (T-STD) Buffer Analyzer — анализирует потоки программы,
моделируя их поведение в модели MPEG-2 T-STD Buffer Model, и соответствие этой модели.
Включает средства отслеживания.

Elementary Stream — Analyzer Elementary Stream — анализирует видеоизображение и уровень аудио.
Включает векторные диаграммы и данные качества изображения макроблока.

Carousel Analyzer — анализ данных, показывающий структуру, скорость передачи данных, частоту
повторения, синтаксис и семантику элементов данных.

Генераторы
Carousel Generator — обеспечивает всестороннюю автономную генерацию сигналов MPEG-2,
транспортных потоков DVB, содержащих ряд протоколов широковещательной передачи данных.

1 «Если установлено и имеет лицензию».
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Приложение Значок  1

ISDB-T Remux – перераспределение каналов существующего 188- или 204-байтного файла
транспортных потоков в файл. совместимый с ISDB-T/Tb (ARIB STD-B31) (204 байта на пакет).
Созданный файл имеет расширение .RMX и включает в себя разделы TMCC и IIP.

Multiplexer — совместное уплотнение табличной информации и пакетированных элементарных
потоков, чтобы синтезировать новые транспортные потоки. Обеспечивается уровень точного
контроля, позволяющий установить несоответствия и тестовые примеры для новых транспортных
потоков.

TS Editor — просмотр и редактирование пакетов транспортного потока с использованием
шестнадцатеричного представления содержимого пакета и семантической интерпретации заголовка.
Предоставляет средства для переназначения идентификаторов пакетов (PID), повторного
вычисления значений пиковой скорости передачи (PCR) и введения погрешностей PCR.

Проигрыватели
MPEG Player — воспроизводит транспортные потоки MPEG-2.

Служебные программы
Make Seamless Wizard — программа-мастер, помогающая пользователю создать файл транспортного
потока MPEG-2 для использования проигрывателя Stream Player в непрерывном циклическом
режиме.

Stream Cutter — извлекает фрагменты из файлов MPEG-2 для вставки в новые файлы.

Script Pad — дает пользователям возможность создавать и изменять сценарии системной
информации (SI).

TTS Utility — преобразует транспортные потоки с метками времени в стандартную форму
транспортного потока.

1 «Если установлено и имеет лицензию».
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Запуск приложения
Все приложения открываются из меню Start (Пуск) > All Programs (Все программы) > Tektronix MTS4000 или с помощью
ярлыков на рабочем столе (Real Time Analyzers (Анализаторы реального времени), Deferred Time Analyzers
(Анализаторы отложенного времени), Generators (генераторы), Player (Проигрыватель) или Utilities (Служебные
программы)).

ПРИМЕЧАНИЕ. Для доступа ко второй карте RF/IP (нижнее гнездо) необходимо использовать значок TS Compliance
Analyzer P1 в папке «Real Time Analyzers» на рабочем столе.

Полные описания всех приложений приведены в руководстве пользователя по приложениям для системы MTS4000 . В
следующей таблице показана иерархия приложений в меню Start (Пуск).

Иерархия меню «Пуск»
Tektronix MTS4000 > OptionKey Wizard

Анализаторы > Buffer Analyzer
Carousel Analyzer
ES Analyzer
PES Analyzer
TS Compliance Analyzer

Генераторы > Carousel Generator
ISDB-T Remux
Multiplexer
TS Editor

Проигрыватель > MPEG Player
Служебные программы > Make Seamless Wizard

ScriptPad
Stream Cutter
TTS Utility

ПРИМЕЧАНИЕ. Несмотря на то, что все приложения отображаются в меню Start (Пуск), доступны только те, на
которые были приобретены лицензии.
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Работа в дуплексном режиме
Прибор MTS4000 может работать в дуплексном режиме (только опция ASI или IP). Например, в то время как
проигрыватель воспроизводит поток, приложение Transport Stream Compliance Analyzer (TSCA) может анализировать
отдельный поток или, если выход отправляется назад на вход, контролировать проигрыватель.

Настройка контура обратной связи
С контуром обратной связи можно выполнять следующие операции:

■ Использовать проигрыватель MPEG Player для воспроизведения потока
■ Направить выход прибора на вход (например, с картой ASI замкнуть ASI-4 на ASI-3; с картой 10G замкнуть выход на

вход с помощью многомодового кроссировочного кабеля).
■ Контролировать/анализировать входной поток с помощью TSCA

Предварительно сделайте следующее:
■ Укажите поток, который будет воспроизводиться (в этом примере используется тестовый поток sym1.mpg).
■ Выберите выходной/входной интерфейс (ASI) и выполните необходимые соединения (создайте контур между

разъемами).

В следующем примере поток отправляется назад с помощью интерфейса ASI и зациклен в проигрывателе (для
непрерывного воспроизведения).

Установка MTS4000.

1. Соедините кабелем разъемы ASI-4 и ASI-3.

Настройка проигрывателя MPEG Player.

1. Откройте приложение MPEG Player: Start > All Programs > Tektronix MTS4000 > Player > MPEG Player (Пуск > Все
программы > Tektronix MTS4000 > Проигрыватель).

2. Откройте поток: File>Open... (Файл > Открыть...). > Sym1.mpg.

ПРИМЕЧАНИЕ. Поставляемый в комплекте файл Sym1.mpg помогает пользователю понять работу
приложений MTS4000. Данный файл доступен в нескольких местах, в частности на жестком диске MTS4000 (в
папке с:\TestStreams), на DVD Tclips MPEG Test Streams (Тестовые потоки MPEG Tclips) и компакт-диске
Documentation Browser (Просмотр документации).

3. Установите следующие настройки в меню Play (Воспроизведение):

■ Интерфейс: ASI
■ Packet size (Размер пакета): 188
■ Update (Обновление): Вкл.
■ Loop (Цикл): Вкл.
■ Other (Другое): Standard (Стандарт): DVB

4. Установите следующие настройки в меню ASI:

■ ASI Out (выход ASI): ASI-4
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Настройка TSCA.

1. Откройте TSCA: Start > All Programs > Tektronix MTS4000 > Analyzers > TS Compliance Analyzer (Пуск > Все
программы > Tektronix MTS4000 > Анализаторы > TS Compliance Analyzer). 

2. В стартовом диалоговом окне Open Transport Stream... (Открыть транспортный поток…) выберите Change…
(Изменить...) в Stream Interpretation (Представление потока) и установите базовый стандарт DVB без расширений.
Закройте диалоговое окно Stream Interpretation (Представление потока).

3. Перейдите к Real-time Analysis (Анализ в реальном времени) и выберите ASI-3 из раскрывающегося списка
Interfaces (Интерфейсы).

4. Нажмите кнопку OK (ОК).

Запуск воспроизведения и анализа.

1. Вернитесь в окно проигрывателя MPEG Player и воспроизведите поток, выбрав: Play>Start/Stop (Воспроизведение
> Пуск/Стоп) или используйте кнопку на панели инструментов.

2. Удостоверьтесь, что в окне проигрывателя появилась строка состояния и началось воспроизведение.

3. Вернитесь в окно TSCA и убедитесь, что анализ начался.

Проигрыватель MPEG Player теперь воспроизводит транспортный поток sym1.mpg, а TSCA контролирует и анализирует
этот поток через вход ASI и выход на панели разъемов прибора.

Для получения подробной информации о проигрывателе MPEG Player и TSCA см. Руководство пользователя
приложений-анализаторов системы MTS4000.

Индикаторы статуса интерфейсной карты
На задней панели дополнительных интерфейсных карт ASI и DVB-S2 (опция DS2) имеется светодиод, указывающий
состояние сигналов входа и выхода. В таблице ниже представлены возможные состояния.

Таблица 2: Выходы ASI и DVB-S2

Схема индикаторов Описание
Быстро мигает оранжевым Нет выходного сигнала
Медленно мигает оранжевым Нулевое содержимое пакетов (нет реальных данных)
Горит оранжевым Идет передача данных

Таблица 3: Входы ASI и DVB-S2

Схема индикаторов Описание
Быстро мигает зеленым Нет несущей/сигнала
Медленно мигает зеленым Обнаружена несущая, но нет данных
Горит зеленым Обнаружен действительный сигнал
Горит красным Подключен неправильный сигнал
Пять коротких красных вспышек друг за другом Нарушения кодекса
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Работа с плавающей лицензией (только с дополнительным модулем FLT)
Если в системе MTS4000 или MTS4SAV3 установлено дополнение FLT, возможна ситуация, когда запустить выполнение
приложения MTS4SA не удается, поскольку все плавающие лицензии уже используются. Чтобы принудительно
завершить удаленное выполнение приложения MTS4SA и освободить лицензию для использования, следует выполнить
следующие действия: 
1. Зарегистрируйтесь с правами Administrator (Администратора) на серверной ЭВМ плавающих лицензий.
2. Откройте Панель управления (Control Panel, Windows Start (Пуск) > Settings (Настройки) > Control Panel (Панель

управления) и выберите значок DESkey. Отобразится диалог настройки конфигурации DESkey (выводимый в
нижней части окна номер версии может меняться).
 

 
3. Выберите вкладку Networking (Сеть) и нажмите кнопку Monitor (Монитор). Отобразится диалоговое окно DK2

Network Server Remote Monitor (Удаленный монитор сетевого сервера DK2).
 

 
4. В диалоговом окне DK2 Network Server Remote Monitor (Удаленный монитор сетевого сервера DK2) нажмите кнопку

Admin.
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5. В поле Password Required (Требуется пароль) ведите значение пароля deskey и нажмите OK. Выводится
диалоговое окно DK2 Network Server (Сетевой сервер DK2) - Forced Workstation Licensing (Принудительное
лицензирование рабочей станции) - Remote Admin (Удаленное администрирование), как в показанном ниже
примере.
 

 

6. В диалоговом окне DK2 Network Server (Сетевой сервер DK2) - Forced Workstation Licensing (Принудительное
лицензирование рабочей станции) - Remote Admin (Удаленное администрирование) нажмите вкладку General
Settings (Общие настройки), а затем выберите клиентскую ЭВМ, где требуется принудительно освободить
программную лицензию MTS4SA.

7. После выбора требуемой клиентской ЭВМ нажмите кнопку Logout (Выход).

8. Проверьте, что в окне подтверждения была выбрана требуемая клиентская ЭВМ, и нажмите Yes (Да) для
продолжения операции принудительного завершения программы.
 

 

9. После окончания операции принудительного завершения программы выбранная плавающая лицензия MTS4SA
возвращается в пул доступных лицензий. При необходимости освобождения дополнительных лицензий повторите
эту процедуру столько раз, сколько лицензий требуется освободить.

10. После освобождения требуемого числа лицензий нажмите OK для закрытия диалога DK2 Network Server (Сетевой
сервер DK2) - Forced Workstation Licensing (Принудительное лицензирование рабочей станции) - Remote Admin
(Удаленное администрирование).
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Процедуры

Использование приложения Multiplexer
В следующем примере показано, как с помощью приложения Multiplexer создать новый транспортный поток и добавить к
нему элементарные потоки.

Новый транспортный поток (с именем TestMux.mpg), созданный согласно этой процедуре, будет использоваться для
выполнения некоторых дополнительных процедур из данного руководства.

Создание нового потока с помощью приложения Multiplexer
В этом разделе описано создание нового транспортного потока с помощью приложения Multiplexer. Здесь будет
специально допущена одна ошибка, с тем чтобы ее можно было найти в следующем разделе, в котором
рассматривается пример использования другого приложения.

1. Откройте приложение Multiplexer. Start
> All Programs > Tektronix MTS4000 >
Generators > Multiplexer (Пуск > Все
программы > Tektronix MTS4000 >
Генераторы > Multiplexer).

2. Выберите View > Interpretation (Вид >
Интерпретация).

3. В диалоговом окне Stream Interpretation
(Интерпретация потока) для Base
Standard (Основной стандарт) должно
быть выбрано DVB, а для Region
(Регион) — None (Нет).

4. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Stream Interpretation
(Интерпретация потока).
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5. Выберите File > New (Файл > Создать).

6. В окне Navigator (Навигатор) выделите
узел транспортного потока, затем в
контекстном меню выберите
Properties (Свойства).

7. В диалоговом окне Stream Properties
(Свойства потока) установите скорость
передачи 24,128 Мбит/с и
фиксированную длительность две
минуты (120 секунд). Нажмите кнопку
OK.

Удостоверьтесь, что эти два значения
отображаются в строке состояния. 

8. В окне Navigator (Навигатор) выделите
узел транспортного потока и выберите
Add (Добавить) в контекстном меню.
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9. В диалоговом окне Transport Stream
Settings (Параметры транспортного
потока) введите 1 в качестве
идентификатора транспортного потока.

10. Нажмите кнопку значка папки PAT
(Таблица распределения программ),
чтобы открыть диалоговое окно PAT
Timing (Синхронизация PAT).

Удостоверьтесь, что на вкладке Version
Timing (Версия синхронизации)
установлено Start time (Время запуска) (0 с)
и Stop time (Время остановки) (120 с), — это
означает, что время передачи PAT будет
входить в длительность потока. 

11. Нажмите кнопку OK, чтобы закрыть
диалоговое окно PAT Timing
(Синхронизация PAT).

12. В диалоговом окне Transport Stream
Settings (Параметры транспортного
потока) выберите Next (Далее).

13. В диалоговом окне Optional Tables for
the Stream (Дополнительные таблицы
потока) установите флажок TDT
(Таблица времени и даты) и нажмите
на кнопку со значком папки TDT.
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В диалоговом окне TDT Timing
(Синхронизация TDT) подтвердите, что
Start time (Время запуска) равно нулю, а
Stop time (Время остановки) соответствует
ранее установленному значению. 

Обратите внимание, что время может
незначительно измениться. В этом примере
была задана длительность 120 с, а теперь
отображается 119,999976127 с. 

14. Для Cycle Time (Время цикла) введите
1000 мс.

15. Нажмите кнопку OK, чтобы закрыть
диалоговое окно TDT Timing
(Синхронизация TDT).

16. В диалоговом окне Optional Tables for
the Stream (Дополнительные таблицы
потока) установите флажок NIT
(Таблица сетевой информации) и
нажмите кнопку настройки NIT.

17. В диалоговом окне Set up the NIT
(Настройка NIT) введите для
идентификатора сети (Network Id)
1234, а для имени сети (Network Name)
– Tek_test.

18. Установите идентификатор
оригинальной сети (Original Network)
2 и выберите Terrestrial (Наземная) в
раскрывающемся списке Delivery
System (Система доставки).

19. Нажмите кнопку Delivery System
Settings (Настройки системы доставки).
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20. В диалоговом окне Terrestrial Settings
(Наземные параметры) введите
0x123456 в поле Centre Frequency
(Центральная частота).

21. Выберите 2 (64-QAM) в
раскрывающемся списке Constellation
(Совокупность).

22. В выпадающем списке Hierarchy
Information (Информация об иерархии)
выберите 4 (non-hierarchical, in-depth
interleaver) (без иерархии, с
глубинным чередованием).

23. Выберите 1 (8k mode) (режим 8 К) в
раскрывающемся списке Transmission
Mode (Режим передачи).

24. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Terrestrial Settings
(Наземные параметры).

25. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Set up the NIT
(Настройка NIT).

26. В диалоговом окне Optional Tables for
the Stream (Дополнительные таблицы
потока) выберите Next (Далее), чтобы
открыть диалоговое окно Transport
Wizard Complete (Завершение
настройки транспортного потока).

Настройка транспортного потока
теперь завершена. Теперь необходимо
добавить некоторый контент в форме
видео- и звуковых элементарных
потоков. 

Не закрывайте окно Transport Wizard
Complete (Завершение настройки
транспортного потока). 
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Регистрация элементарного потока. В этом примере требуется добавить элементарные потоки видео и звука в
созданный ранее транспортный поток. Подходящие потоки можно извлечь из одного из типовых транспортных потоков,
поставляемых в составе установочного комплекта MTS4000. В этом примере используется поток Sym1.mpg. Файл с
потоком доступен на жестком диске MTS4000, испытательный поток Tclips MPEG Test Streams на диске DVD и на
компакт-диске Documentation CD.

1. Запустите вторую копию приложения
Multiplexer. Start > All Programs >
Tektronix MTS4000 > Generators >
Multiplexer (Пуск > Программы >
Tektronix MTS4000 > Генераторы >
Multiplexer).

2. Выберите File > Open (Файл >
Открыть).

3. В диалоговом окне Set MPEG File to
Edit (Выбрать файл MPEG для
редактирования) выберите и откройте
файл sym1.mpg.

4. Откройте узел программы program 1 и
зависимый узел Elementary Streams
(Элементарные потоки).

5. Выделите узел с PID 110. Этот узел
передает элементарный поток
видеосигнала MPEG-2.

6. Выберите в контекстном меню Export
Elementary Stream (Экспорт
элементарного потока).

7. В диалоговом окне Save As (Сохранить
как...) введите имя файла
(Sym1pid110.es) и сохраните файл в
подходящей папке.

8. Повторите эти действия для PID120.
Назовите файл Sym1pid120.es.

9. Выберите File > Exit (Файл > Выход),
чтобы закрыть эту копию программы
Multiplexer.

Этим завершается извлечение видео-
и звуковых элементарных потоков.
Теперь можно продолжить выполнение
задачи мультиплексирования. 
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Добавление элементарных потоков. Теперь можно возвратиться к оригинальному экземпляру мультиплексора и
добавить элементарные потоки, которые были созданы ранее.

1. Удостоверьтесь, что установлен
флажок Add a Program Wizard
(Добавить мастер программы) и
нажмите кнопку Next (Далее).

2. В диалоговом окне Add a Program
(Добавить программу) введите 1 в
качестве номера программы.

3. Выберите значок папки PMT.

4. В диалоговом окне PMT Timing
(Синхронизация PMT) выберите
вкладку Subtable Timing
(Синхронизация подтаблицы).

Цикл подтаблицы — это период
времени, через который таблица
повторяется в потоке. Максимальное
время цикла для PMT в стандарте DVB
составляет 500 мс. 

5. В этом примере установлено время
цикла 525 мс.

6. Нажмите кнопку OK, чтобы закрыть
диалоговое окно PMT Timing
(Синхронизация PMT).
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7. В диалоговом окне Add a Program
(Добавить программу) выберите Next
(Далее).

8. В диалоговом окне Add Service
Description (Добавить описание
службы) поставьте флажок Add
Service Description (Добавить
описание службы).

9. Введите данные в поле Service
Provider Name (Наименование
поставщика услуг), например Tek
Broadcasting.

10. Введите данные в поле Service Name
(Наименование службы), например
Tek1.

11. Введите данные в поле Service Type
(Тип службы), например 1 (0 x 1)
(цифровое телевидение).

12. Выберите Next (Далее).

13. В диалоговом окне Add the Program
Content (Добавить содержимое
программы) выберите Add (Добавить),
чтобы добавить элементарный поток
видео.
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14. В диалоговом окне Add Program Stream
(Добавить поток программы) выберите
2 (0x02) (MPEG-2 Video) в
раскрывающемся списке Stream Type
(Тип потока).

15. Удостоверьтесь, что вкладка Source
(Источник) выбрана.

16. Введите имя файла или используйте
кнопку Browse (Обзор), чтобы найти
элементарный поток видео,
подготовленный ранее
(Sym1pid110.es).

17. Выберите видеоформат MPEG-2 в
раскрывающемся списке File type (Тип
файла). Обратите внимание, что
скорость передачи была введена
автоматически.

Выберите вкладку Timing (Синхронизация).
Обратите внимание, что этот
элементарный поток будет иметь ту же
длительность, что и ранее заданный поток,
то есть 120 мс. 

18. Выберите вкладку PCR.
Удостоверьтесь, что установлен
флажок Carry PCR (Перенос PCR).
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19. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Add Program Stream
(Добавить поток программы).

20. В диалоговом окне Add the Program
Content (Добавить содержимое
программы) снова выберите Add
(Добавить), чтобы добавить
элементарный поток аудио.

21. Выберите 3 (0 x 03) (MPEG-1 Audio) в
раскрывающемся списке Stream Type
(Тип потока).

22. В диалоговом окне Add Program Stream
(Добавить поток программы)
удостоверьтесь, что выбрана вкладка
Source (Источник).

23. Введите имя файла или используйте
кнопку Browse (Обзор), чтобы найти
элементарный поток аудио,
подготовленный ранее
(Sym1pid120.es).

24. Выберите формат MPEG-2 audio в
раскрывающемся списке File type (Тип
файла). Обратите внимание, что
скорость передачи была введена
автоматически.

25. Выберите вкладку Timing
(Синхронизация). Обратите внимание,
что этот элементарный поток будет
иметь ту же длительность, что и ранее
заданный поток, то есть 120 мс.

26. Выберите вкладку PCR.
Удостоверьтесь, что флажок Carry
PCR (Перенос PCR) снят.

27. Введите в поле PID PCR значение 33.
Это PID, который будет переносить
информацию PCR, — также
видеофайл с расширением es, Carry
PCR.

28. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Add Program Stream
(Добавить поток программы).

29. Выберите Next (Далее).
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30. В диалоговом окне Event Information
(Информация о событии) поставьте
флажок Event Information Tables (EIT —
таблицы информации о событиях).

31. Удостоверьтесь, что установлен
флажок Present (Текущие).

32. Выберите Present Settings (Текущие
параметры).

33. В диалоговом окне Present Events
(Текущие события) выберите Add
(Добавить), чтобы задать информацию
текущего события, то есть время его
вещания. В диалоговом окне Event
(Событие) выберите 4 (текущее) в
раскрывающемся списке Status
(Состояние).

34. Установите Start Time (Время начала)
2008-08-28 10:20:00 AM.

Можно изменить время и дату,
выделив отдельное поле и введя
требуемое значение. 

35. Введите данные в поле Event Name
(Наименование события), например
Tek World.

36. Введите данные в поле Description
(Описание), например The future of
Tek.

37. Введите данные в поле Duration
(Длительность), например 30 мин
(00:30:00).

38. Выберите 257 (MPEG-2 video,
4:3 aspect ratio, ...) в раскрывающемся
списке Content/Component Type (Тип
контента/компонента).

39. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Event (Событие).
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40. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Present Events
(Текущие события).

41. Удостоверьтесь, что установлен
флажок Following (Следующие).

42. Выберите Following Settings
(Следующие параметры).

43. Выберите Add (Добавить), чтобы
задать информацию о следующем
событии, то есть событии, которое
следует за текущим.

44. В диалоговом окне Event (Событие)
введите 1 в поле Event Id
(Идентификатор события).

45. Выберите 1 (not running) (не
выполняется) в раскрывающемся
списке Status (Статус).

46. Установите Start Time (Время начала)
2008-08-28 10:50:00 AM.

47. Введите данные в поле Event Name
(Наименование события), например
Tek News.

48. Введите данные в поле Description
(Описание), например All the latest
news from Tek.

49. Введите данные в поле Duration
(Длительность), например 30 мин
(01:00:00).

50. Выберите 257 (MPEG-2 video,
4:3 aspect ratio, ...) в раскрывающемся
списке Content/Component Type (Тип
контента/компонента).

51. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Event (Событие).

52. Нажмите кнопку OK, чтобы закрыть
диалоговое окно Following Events
(Следующие события).

53. В диалоговом окне Event Information
(Информация о событии) нажмите
Next (Далее).
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54. В диалоговом окне Program Complete
(Завершение программы) выберите
Finish (Готово).

Создание структуры и содержимого
демонстрационного транспортного потока
завершено. Теперь можно провести
несколько проверок, чтобы убедиться в
соответствии потока требованиям. 

55. Выберите View > Available Bitrate
(Вид > Доступная скорость передачи).

Обратите внимание, что доступная
скорости передачи на графике
Available Bitrate остается в пределах
заданного значения, то есть
124,128 Мбит/с. 

Можно проверять скорость передачи
информации в любой точке на
графике, щелкая по любой точке и
считывая значения в смежной
таблице. 

56. Закройте график Available Bitrate
(Доступная скорость передачи).

57. Выберите Multiplex > Start (Multiplex >
Пуск), чтобы запустить приложение
Multiplex.
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58. В диалоговом окне Set TS Output File
(Установка выходного файла TS)
введите имя нового мультиплексного
транспортного потока: TestMux.mpg.
(Этот новый транспортный поток
используется в других процедурах.)

В правой части строки состояния
можно наблюдать за прогрессом
мультиплексирования, однако
индикатор выполнения может быть
скрыт, если окно слишком мало по
горизонтали. 

Теперь элементарные потоки и
структурная информация
мультиплексированы вместе, чтобы
сформировать транспортный поток —
TestMux.mpg. 

59. Хорошая идея — сохранить структуру
уплотнения, так чтобы ее можно было
использовать периодически для
добавления дополнительной
информации, когда в этом возникнет
необходимость.

60. Щелкните File > Export (файл >
экспорт).

61. В диалоговом окне Export File (Экспорт
файла) введите имя мультиплексного
файла структуры, например
TestMux.muxml и выберите место, в
которое этот файл будет сохранен.
Обратите внимание на расширение
muxml.

62. С помощью команды File > Import
(Файл > Импорт) мультиплексный
файл структуры можно открыть в
любое время, чтобы добавить
элементарные потоки или структурную
информацию.
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Использование приложения Transport Stream Compliance Analyzer (TSCA)
В следующей процедуре транспортный поток исследуется в режиме офлайн с помощью режима File Analysis (Анализ
файла) приложения Transport Stream Compliance Analyzer (TSCA). В этой процедуре используется транспортный поток
(TestMux.mpg), созданный в процедуре Использование приложения Multiplexer.

Используйте функцию Real-time Analysis (Анализ в реальном времени) для анализа непосредственно поступающих
данных. Отслеживание нескольких источников входных сигналов. на странице 69

1. Откройте приложение Transport Stream
Compliance Analyzer (Анализатор
соответствия транспортного потока).
Start > Programs > Tektronix MTS4000
> Analyzers > TS Compliance Analyzer
(Пуск > Программы > Tektronix
MTS4000 > Анализаторы > TS
Compliance Analyzer).

Диалоговое окно Open File Analysis
(Анализ открытого файла) открывается
автоматически. Если этого не
происходит, выберите элемент File
Analysis (Анализ файла) панели
инструментов TSCA Analysis. 

Удостоверьтесь, что в диалоговом окне
Open File Analysis (Открыть анализируемый
файл) для Base Standard (Основной
стандарт) выбрано DVB, а для Region
(Регион) — No (Нет). 

2. Найдите и выберите
демонстрационный поток
TestMux.mpg.

Удостоверьтесь, что на панели
Advanced Settings (Дополнительные
настройки) значения для скорости
потока (Stream Bit Rate) и меток
времени (Timestamp Settings)
соответствуют показанным на
рисунке. 
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3. Продолжительность анализа
составляет около минуты.

4. Выберите вкладку Analysis (Анализ),
чтобы отобразить структуру навигации
и связанные представления.

5. Выберите вкладку Programs
(Программы) и раскройте узлы в
навигационном представлении,
щелкая символы +.

Удостоверьтесь, что Итоговое
представление (Summary view) и
Тестовое представление (Tests view)
отображаются в подробных видах. 

Узел Transport Stream (Транспортный
поток) и узел Program (Программа)
отображаются красным цветом. Это
показывает, что в потоке произошла
ошибка, которая все еще является
активной. 

6. Выделите узел Transport Stream
(Транспортный поток). В подробном
представлении Tests Summary (Итоги
теста) на вкладке TR 101 290 показана
ошибка теста 1.5.a PMT, то есть
соответствующий светодиод светится
красным цветом.
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7. Выделите тест 1.5.a PMT и выберите в
контекстном меню View this test
(Просмотреть тест) в дереве Tests
(Тесты).

Отобразятся представления вкладки Tests
(Тесты). Представление навигации
расширено, чтобы показать тест,
содержащий ошибку. На подробном
представлении показаны все PID,
связанные с выделенным тестом (в этом
примере их нет), и журнал регистрации
событий с фильтром, настроенным на
отображение событий только для
выделенного теста. 

Проверьте записи журнала, чтобы найти
информацию об ошибке. Обратите
внимание, что в сообщении об ошибке
указана длительность 525 мс. Это частота
повторения раздела PMT; значение 525 мс
было установлено для потока, созданного
ранее в качестве примера. 
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8. В навигационном представлении
выделите тест 1.5 PMT (Таймер) и
выберите Edit Parameters
(Редактировать параметры) в
контекстном меню.

9. Обратите внимание, что в диалоговом
окне Edit Parameters (Редактировать
параметры) для этого потока
максимальный период повторения
раздела PMT установлен равным
500 мс. Так как частота повторения,
обнаруженная в этом потоке,
превышает это значение (525 мс),
появляется сообщение об ошибке. Тем
не менее, исследуя максимальные и
минимальные частоты повторения,
показанные в диалоговом окне Edit
Parameters (Редактировать
параметры) (для этого нужно
задержать курсор в поле значения и
просмотреть всплывающую подсказку),
можно видеть, что величина 525 мс
находится в пределах диапазона,
рекомендуемого стандартом DVB: от
40 до 25 000 мс.
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Использование приложения PES Analyzer
Элементарные потоки (включающие видео, аудио и вспомогательные данные) объединяются в пакетированный
элементарный поток (PES). Заголовок, связанный с каждым пакетом PES в транспортном потоке, особенно интересен,
поскольку он содержит метки времени декодирования и представления (DTS и PTS) для включенных элементарных
потоков. Сбои в метках времени могут в крайних случаях вызвать проблему сброса приемника или остановки
изображения.

1. Откройте приложение PES Analyzer.
Start > All Programs > Tektronix
MTS4000 > Analyzers > PES Analyzer
(Пуск > Все программы > Tektronix
MTS4000 > Анализаторы > PES
Analyzer).

2. Выберите File > Open (Файл >
Открыть). Найдите и откройте
транспортный поток. Например, можно
выбрать файл TestMux.mpg,
созданный в процедуре
Использование приложения Multiplexer.

Ход анализа отображается в строке
состояния и в журнале регистрации
событий. После завершения анализа
появляется окно Program Structure
(Структура программы). В этом
примере можно видеть, что поток
несет одну программу, которая
содержит один видео- и один звуковой
элементарные потоки с
идентификаторами PID 33 и
34 соответственно. 
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3. Выберите видеопоток в окне Program
Structure (Структура программы);
значок лупы укажет, что поток выбран.

4. Откройте каждую из опций в меню
View (Вид), то есть: Event Log (Журнал
событий), Hex (Шестнадцатеричн.),
Interpretation (Интерпретация) и PTS/
DTS Timing (Синхронизация PTS/DTS).
Каждое действие открывает новое
представление в окне PES Analyzer.
Может быть полезно присвоить
заголовки представлениям, используя
команду Window > Tile (Окно >
Расположить).

Для перехода к любому пакету в
потоке PES можно использовать
ползунок, расположенный выше строки
состояния. Пакеты пронумерованы в
пределах идентификатора PID
согласно их позициям в файле.
Ползунок показывает номер и PID
текущего пакета. 

Представление Packet Hex: 

В этом представлении можно исследовать
каждый байт в PES. 

■ Четырехзначные числа в левом
столбце — адреса первого байта в
строке.

■ Байты, отображаемые сиреневым
цветом, представляют заголовок
пакета PES. То же самое просмотреть
в графическом виде в представлении
Packet Interpretation (Формат пакета).
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Представление Packet Interpretation: 

То же самое можно просмотреть в
графическом представлении Packet
Interpretation (Формат пакета). Размер
заголовка изменяется в зависимости от
содержимого пакета. 

Представление PTS/DTS: 

Это представление показывает временной
анализ выбранного потока. Ось X
показывает длительность потока в
секундах. Ось Y показывает различия
между ожидаемыми и фактическими
значениями DTS. Вертикальные синие
линии показывают различие между PTS и
DTS для каждого устройства доступа.
Дополнительная информация об
устройстве доступа отображается на
боковой панели. 

Для потока, соответствующего
требованиям, каждое значение DTS
отображается в точках 0 мс на оси Y; для
потоков с ошибками характерны
ступенчатые графические эффекты. 

Выберите лупу на инструментальной
панели и щелкните по представлению,
чтобы увеличить или уменьшить график.
Ползунок внизу этого окна указывает, где
расположены показанные пакеты
относительно остальной части файла. 
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Использование T-STD Buffer Analyzer
Приложение T-STD Buffer Analyzer моделирует поведение буферных регистров в гипотетическом Transport Stream
System Target Decoder (Целевой декодер системы транспортного потока) согласно стандарту ISO/IEC 13818-1. Он может
обрабатывать видео- и аудиопотоки, а также потоки проверки системы. В результатах анализа показаны графики
зависимости емкости буфера от времени, а также журнал исключений и важных событий. Последствия несоответствия
буферной модели могут включать стоп-кадры и сбросы приемника.

1. Откройте T-STD Buffer Analyzer. Start >
Programs > Tektronix MTS4000 >
Analyzers > Buffer Analyzer (Пуск >
Программы > Tektronix MTS4000 >
Analyzers > Buffer Analyzer).

2. Просмотрите параметры
конфигурации. View > Settings (Вид >
Параметры).

На вкладке System (Система)
диалогового окна Settings (Параметры)
выберите MPEG2 Packet Interpretation
(Формат пакета MPEG2), затем
выберите Pre-Scan Packets All
Packets (Предварительно
сканированные пакеты: все пакеты). 
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3. На вкладке Video (Видео) выберите
Buffer Sizes (Размеры буферов) —
Automatic (Автоматически) и Data
Transfer (Передача данных) —
Automatic (Автоматически).

4. На вкладке Audio (Аудио) выберите
Buffer Sizes (Размеры буферов) —
Automatic (Автоматически).

5. Закройте диалоговое окно Settings
(Параметры).
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6. Выберите файл для анализа. File >
New (Файл > Создать).

7. Найдите и откройте файл MPEG.
Например, можно выбрать файл
TestMux.mpg, созданный в процедуре
Использование приложения Multiplexer.

Диалоговое окно для выбора файла
будет немедленно открыто.
Пользователь должен назвать и
открыть файл результатов буферной
модели (BMR), который будет
использоваться для хранения
результатов последующего анализа. 

Примите имя по умолчанию и откройте
файл. 

Программа выполняет начальный
анализ, чтобы сформировать список
потока и вычислить среднюю скорость
передачи. Список потока показывает
все программы и элементарные потоки
в файле. Все потоки в списке
отмечены как необработанные, потому
что никакой анализ еще не был
выполнен для них в этом сеансе. 

8. Чтобы начать обработку потока,
выберите Process Streams
(Обработка потоков) из контекстного
меню.

Ход выполнения анализа будет
отображаться в строке состояния. 
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9. Выделите PID 33 и выберите All
Buffers (Все буферы) из контекстного
меню.

Для элементарного потока
видеоданных будут отображены
следующие окна: PID Event Log
(Журнал событий PID), Video Transport
Buffer (Транспортный буфер видео),
Video Multiplex Buffer (Мультиплексный
буфер видео) и Video Elementary Buffer
(Элементарный буфер видео). (Окно
Stream List (Список потока) будет
свернуто.) 

10. Присвойте заголовки появившимся
окнам: Window > Tile (Окно >
Расположить).

PID Event Log (Журнал событий PID): 

Можно открыть два журнала событий:
журнал глобальных событий (View >
Global Event Log), который
отображает главные события процесса
начального анализа, и журнал событий
PID (View > PID Event Log), который
отображает события для каждого
обрабатываемого PID. 

Для следующих графиков буферов
доступны следующие возможности: 

■ Используйте значки лупы на
инструментальной панели, чтобы
увеличить или уменьшить выбранный
график. Измененный масштаб
изображения может быть сброшен с
помощью кнопки Reset Zoom (Сброс
лупы) на панели инструментов.

■ Все открытые графики можно
использовать отдельно. Чтобы
синхронизовать все представления с
выбранным в настоящий момент
представлением, используйте
команды: Options > Synchronize Views
(Настройки > Синхронизовать
представления).

■ Красные линии по оси Y указывают
пределы 0% и 100%.

 

 Процедуры

Краткое руководство по эксплуатации систем MTS4000 и MTS4SAV3 с заводскими номерами B020101 и последующими 59



Video Multiplex / Main Buffer
(Мультиплексный/главный буфер видео): 

В этом представлении для видеопотоков
можно просмотреть результаты
моделирования мультиплексного буфера.
Для аудиопотока и потока управления
системой можно просматривать результаты
для основного буфера. Строка заголовка
показывает тип потока. 

Video Transport Buffer (Транспортный
буфер видео): 

Это представление показывает результаты
моделирования транспортного буфера для
видео- и аудиопотоков, а также для потока
управления системой. 

Video Elementary Buffer (Элементарный
буфер видео): 

Это представление показывает только
соответствующие элементарные потоки
видеоданных. 

11. Чтобы открыть журнал трассировки,
выберите View > Trace (Вид >
Трассировка).

Журнал трассировки поможет
проанализировать сообщения,
созданные Buffer Analyzer. Эти
журналы могут быть полезными для
всестороннего исследования
внутренней обработки, особенно для
видеопотока. У трассировочного
представления есть возможности
фильтрации, которые позволяют
сосредоточиться на особенно
интересных типах сообщений. 
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Использование приложения ES Analyzer.
Приложение ES Analyser (анализатор элементарных потоков) предназначено для проверки соответствия кодеков
стандартам MPEG-2 и H.263. Кроме того, поддерживается декодирование и отображение аудиосигналов стандартов
MPEG-2 (ISO/IEC 13818 части 3 и 7), AC-3 и MPEG-4 AAC.

ES Analyzer — это комплексное приложение, которое можно использовать для анализа различных аспектов видео- и
аудиопотоков. Поэтому следующая процедура показывает, как открыть некоторые экраны диагностики; детальное
пояснение их компонентов и значения приведены в Руководстве пользователя приложения-анализатора системы
MTS4000.

1. Откройте приложение ES Analyzer.
Start > All Programs > Tektronix
MTS4000 > Analyzers > ES Analyzer
(Пуск > Все программы > Tektronix
MTS4000 > Анализаторы > ES
Analyzer).

2. Выберите файл для анализа. File >
Open (Файл > Открыть).

Найдите и откройте файл MPEG.
Например, можно выбрать файл
TestMux.mpg, созданный в процедуре
Использование приложения
Multiplexer. 

3. Нажимайте на каждый
последовательный узел в
навигационном окне, пока GOP (Группа
изображений) не выделится на ветви
видео: Program 1 / PES (PID 33), MPEG
2 Video.
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4. Выберите вкладку Picture Player
(Проигрыватель изображений).
Удостоверьтесь, что отображается
пульт дистанционного управления
проигрывателя изображений.

5. Нажмите кнопку Show Information
(Показать информацию), чтобы
развернуть панель управления. В
дополнительной информации
указывается позиция показанного
изображения в файле; подробная
информация отображается также в
строке состояния.

6. Запустите воспроизведение потока,
нажав кнопку воспроизведения на
панели управления.

Если остановить воспроизведение,
можно выбрать другие вкладки GOP
(GOP and Picture (GOP и
Изображение), Slice and MB (Срез и
МВ)) и исследовать характеристики
кадра. 

7. Например, выберите Picture Display
(Отображение изображения) на
вкладке Slice and MB (Срез и МВ).
Изображение будет соответствовать
изображению в Picture Player.

8. Нажмите кнопку Show MV (Показать
векторы движения) слева от экрана
изображения. Для кадров B и P
векторы перемещения будут показаны
как окрашенные стрелки, наложенные
на изображение.
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Дополнительно можно просматривать
характеристики любого из макроблоков,
которые составляют изображение,
задерживая курсор над макроблоком. 

9. Используйте кнопки Previous Frame
(Предыдущий кадр) и Next Frame
(Следующий кадр), чтобы
передвигаться вперед и назад в потоке
и сравнивать векторы перемещения.

Исследовать характеристики аудиопотока
можно аналогичным способом. 

10. Нажимайте на каждый
последовательный узел в
навигационном окне, пока GOP (Группа
изображений) не выделится на ветви
аудио: Program 1 / PES (PID 34), MPEG
1 Audio.

Используйте звуковую панель
управления, чтобы просматривать
аудиозаписи. Для прослушивания
выходного сигнала потребуются
наушники. 
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Дисплей TSCA FlexVuPlus™
В приложении Transport Stream Compliance Analyzer с помощью функции FlexVuPlus™ можно выбрать до четырех
одновременных представлений с подробными данными анализа для упрощения базового и расширенного
диагностического мониторинга транспортного потока.

Для выполнения этого упражнения
закройте все открытые в настоящий
момент панели FlexVuPlus, щелкнув X в
верхнем правом углу каждой панели. 

Это не является обязательным, но может
помочь наблюдать следующую процедуру,
когда каждая панель будет заполнена.
Обратите внимание, что каждая из четырех
панелей FlexVuPlus имеет номер. 

Настройка панели 1 

1. Выберите вкладку Analysis (Анализ), а
затем вкладку Tests (Тесты).

В верхнем правом углу всех детальных
представлений находится кнопка
выбора панели FlexVuPlus. Эту кнопку
можно использовать, чтобы показать
копию этого представления на
выбранной панели FlexVuPlus. 

2. В представлении Test Summary (Итоги
теста) используйте кнопку выбора
панели FlexVuPlus, чтобы вывести это
представление на панель 1.
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3. Дисплей FlexVuPlus теперь отображает
итоги теста на панели 1.

Настройка панели 2. 

4. Выберите вкладку Analysis (Анализ), а
затем вкладку Programs (Программы).

5. В представлении Thumbnails
(Миниатюры) используйте кнопку
выбора панели FlexVuPlus, чтобы
вывести это представление на
панель 2.
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6. Дисплей FlexVuPlus теперь отображает
миниатюры на панели 2.

Настройка панели 3. 

7. Выберите вкладку Analysis (Анализ), а
затем вкладку Tests (Тесты).

8. В представлении Test Failures
(Неудачные тесты) используйте кнопку
выбора панели FlexVuPlus, чтобы
вывести это представление на
панель 3.
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9. Дисплей FlexVuPlus теперь отображает
неудачные тесты на панели 3.

Поскольку в этом примере используются
только три панели, вид миниатюр можно
развернуть на всю правую часть дисплея
FlexVuPlus. 

Чтобы расширить панель 2 по вертикали,
достаточно нажать кнопку развертывания. 

(Точно так же можно расширять панели по
горизонтали, используя кнопку
горизонтального развертывания.) 

10. Разверните панель 2, чтобы показать
полное основное контрольное
представление дисплея FlexVuPlus.
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В итоге этот вид позволяет немедленно просматривать следующие данные:

■ В представлении Test Summary (Итоги теста) (панель 1 FlexVuPlus) — то, какие тесты прошли неудачно.
■ В представлении Test Failures (Неудачные тесты) (панель 3 FlexVuPlus) — то, какие тесты последними закончились

неудачей.
■ В представлении Thumbnails (Миниатюры) (панель 2 FlexVuPlus) — то, какие элементарные потоки в настоящий

момент несут видеоконтент.

Процедуры  

68 Краткое руководство по эксплуатации систем MTS4000 и MTS4SAV3 с заводскими номерами B020101 и последующими



Отслеживание нескольких источников входных сигналов.
Система MTS4000 способна отслеживать несколько транспортных потоков (на отдельных портах 10G или портах
сетевых адаптеров) с помощью нескольких экземпляров приложения Transport Stream Compliance Analyzer.

1. Откройте приложение Transport Stream
Compliance Analyzer (Анализатор
соответствия транспортного потока).
Start > Programs > Tektronix MTS4000
> Analyzers > TS Compliance Analyzer
(Пуск > Программы > Tektronix
MTS4000 > Анализаторы > TS
Compliance Analyzer).

Выберите элемент Real-time
Analysis... (Анализ в реальном
времени) панели инструментов TSCA
Analysis. 

2. В диалоговом окне Select Real-Time
Interface (Выбор интерфейса
реального времени) выберите в
выпадающем меню один из доступных
входных интерфейсов.

В рассматриваемом примере для
мониторинга с помощью приложения
TS Compliance Analyzer выбирается
вход ASI-3. 

Доступные варианты выбора зависят
от имеющихся дополнительных
входов. 
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3. Запустите второй экземпляр
приложения Transport Stream
Compliance Analyzer. Start > Programs
> Tektronix MTS4000 > Analyzers > TS
Compliance Analyzer (Пуск >
Программы > Tektronix MTS4000 >
Анализаторы > TS Compliance
Analyzer).

Выберите элемент Real-time
Analysis... (Анализ в реальном
времени) панели инструментов TSCA
Analysis. 

4. В диалоговом окне Select Real-Time
Interface (Выбор интерфейса
реального времени) выберите в
выпадающем меню один из доступных
входных интерфейсов.

В данном экземпляре TS Compliance
Analyzer для мониторинга был выбран
вход ASI-4. 
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принадлежности

Стандартные принадлежности
В следующей таблице приведены стандартные принадлежности, поставляемые с прибором MTS4000 и программным
обеспечением MTS4SAV3:

Описание Номер по
каталогу

MTS4000 MTS4SAV3

Сертификат соответствия 001-1180-XX ■ ■
Компакт-диск с программным обеспечением: Носитель с программным
обеспечением для систем MTS4000

063-4385-XX ■ ■

Сертификат подлинности: Microsoft Windows 7 — ■
DVD с программным обеспечением: Диск восстановления MTS4000 Operating
System Restore

063-4387-XX ■

Компакт-диск с документацией к системе MTS4000 и MTS4SAV3
На данном компакт-диске содержатся все документы, относящиеся к системе
MTS4000 и ее программному обеспечению.

063-4386-XX ■ ■

Идентификатор упаковки MTS4000 071-2969-XX ■
Краткое руководство по эксплуатации систем серии MTS4000 и MTS4SAV3 071-2970-XX ■ ■
Лист дополнительной информации; ROHS, Китай 071-2185-XX ■ ■
USB-ключ — ■ ■
Шнур питания (один из следующих):

■ Вариант A0 — для Северной Америки
■ Вариант A1 — универсальный европейский разъем
■ Вариант A2 — Великобритания
■ Вариант А3 — Австралия
■ Вариант A4 — Северная Америка, 240 В
■ Вариант А5 — Швейцария
■ Вариант А6 — Япония
■ Вариант А10 — Китай
■ Вариант A11 — Индия
■ Вариант A99 — без шнура питания

— ■
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Варианты комплектации и модернизации

Дополнения
Доступные для заказа дополнительные аппаратные средства и модули программного обеспечения системы MTS4000
перечислены в следующей таблице. В таблице также указаны принадлежности, включаемые в комплект при поставке
дополнений.

Дополнение Описание
Дополнения
аппаратных средств
(только для MTS4000)

ASI Добавляет многопортовый интерфейс ASI.
До четырех портов выходов. Порты 1 и 2 зарезервированы для плат RF
и IP. Порты 3 и 4 доступны для использования в качестве входных.

DS2  1 Добавляет интерфейс DVB-S/S2 с двумя входами с возможностью
демодуляции QPSK/8PSK по двум портам или модуляции 16APSK/
32APSK по одному порту; для одного прибора можно заказать не более
двух дополнительных плат DS2.

VS  2 Добавляет интерфейс 8VSB (требуется дополнение ASI).
Кабель BNC — BNC, 75 Ом (номер по каталогу Tektronix 174-5135-xx)
поставляется в комплекте.

QB22 Добавляет интерфейс QAM B (требуется дополнение ASI).
Кабель BNC — BNC, 75 Ом (номер по каталогу Tektronix 174-5135-xx)
поставляется в комплекте.

IPTV  3 Добавляет интерфейс IPTV Gb Ethernet с электрическим портом
10/100/1000BASE-T, соединитель RJ45 (требуется дополнение ASI).
Кабель BNC — BNC, 75 Ом (номер по каталогу Tektronix 174-5135-xx)
поставляется в комплекте.

SX Добавляет коротковолновый оптический порт 1000Base-SX с приемо-
передающим устройством SFP, имеющим соединитель типа LC, в
качестве интерфейса IPTV Ethernet (многомодовый, 850 нм).

LX Добавляет длинноволновый оптический порт 1000BASE-LX с приемо-
передающим устройством SFP, имеющим соединитель типа LC, в
качестве интерфейса IPTV Ethernet (одномодовый, 1310 нм).

ZX Добавляет оптический порт 1000BASE-ZX с приемо-передающим
устройством SFP, имеющим соединитель типа LC, в качестве
интерфейса IPTV Ethernet (одномодовый, 1550 нм).

10GS  4 Добавляется двойной оптический порт 10GBASE-SR 10 Гбит/с на
сетевой карте. Включает приемо-передающее устройство SFP для
работы с оптическими линиями малой протяженности (850 нм) и
модули ПО.

1 дополнение S2 (в комплекте с платой DVB-S/S2 с одним входом) более не поставляется; заменяется на дополнение DS2 (в комплекте с платой DVB-S/S2 с
двумя входами).

2 дополнения VS и QB2 более не поставляются.
3 Дополнение IPTV недоступно для модели MTS4000-EU.
4 При заказе новых приборов аппаратное дополнение 10GS доступно только при приобретении и не может быть установлено при модернизации после покупки.
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Дополнение Описание
Дополнительные
модули ПО

ПРИМЕЧАНИЕ. Для
модели MTS4SAV3
следует заказать
хотя бы один из
указанных
дополнительных
модулей
программного
обеспечения.

TCMP
(только для модели
MTS4SAV3)

Добавляет модули анализатора соответствия транспортных потоков
Transport Stream Compliance Analyzer (только интерфейс IP) в реальном
или замедленном масштабе времени, модули анализатора Carousel
Analyzer, разделителя транспортных потоков TS Cutter и
проигрывателя MPEG

GEN (Генераторы) Добавляет модули мультиплексора Multiplexer, проигрывателя MPEG
Player, редактора транспортных потоков Transport Stream Editor, ISDB-T
Remux, Make Seamless Wizard, разделителя транспортных потоков
Transport Stream Cutter и Script Pad.
Носитель с испытательным потоком Tclips MPEG Test Stream
поставляется в комплекте.

ESS Добавляет модуль ES стандартного анализа элементарного потока. В
комплекте модуль MTS4CC со всеми дополнениями, а также
анализатор элементарных потоков MPEG-2 ES.

ESB Добавляет функции углубленного анализа элементарного потока.
Включает базовое программное обеспечение MTS4EAV7 (AVC) и
анализатор элементарных потоков MPEG-2 ES.

ESE Добавляет функции углубленного анализа элементарного потока.
Включает ПО MTS4EAV7 со всеми дополнениями (в том числе, HEVC)
и анализатор элементарных потоков MPEG-2 ES.

VQ Добавляет ПО для оценки качества видео с несимметричного входа.
Включает ПО VQS1000 со всеми дополнениями.

PQ Добавляет ПО для оценки качества изображения с симметричного и
несимметричного входа. Включает модуль PQASW с дополнением IP.

PB Добавляет анализаторы PES и содержимого буферной памяти T-STD.
CA Добавляет анализатор титров для CEA608, CEA708, SCTE20/21.

Включает модуль MTS4EAV7 связанный с режимом анализа
соответствия CA.

FLT Добавляет плавающую лицензию (все плавающие лицензии включают
одинаковые возможности); для получения нескольких лицензий
следует заказать соответствующее число дополнительных модулей
FLT

Дополнительный пакет
программного
обеспечения
(только для MTS4000)

430 Включает модули проигрывателя Player, мультиплексора Multiplexer,
испытательные потоки Tclips Test Streams, анализаторы PES и
содержимого буферной памяти, MTS4EAV7 со всеми дополнениями
(включая HEVC), анализатор элементарных потоков MPEG-2 ES.

 принадлежности
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Комплекты обновлений MTS4KUP
Предлагаемые комплекты обновлений MTS4KUP предназначены для расширения возможностей прибора и его
программного обеспечения после приобретения системы тестирования MTS4000 или MTS4SAV3. Комплекты могут
включать программное обеспечение, аппаратные средства или и то, и другое.

Установку оборудования в прибор должен выполнять квалифицированный технический специалист.

Дополнение Описание
Модернизация
аппаратуры MTS4KUP
(только для MTS4000)

ASI Многопортовый интерфейс ASI.
До четырех портов выходов. Порты 1 и 2 зарезервированы для плат RF
и IP. Порты 3 и 4 могут быть использованы в качестве входных.

DS2  1 Интерфейс DVB-S/S2 с двумя входами, позволяет демодулировать
сигналы QPSK/8PSK с двух портов или 16APSK/32APSK с одного
порта; можно заказать не более двух дополнительных плат DS2 для
одного прибора

VS  2 Интерфейс 8VSB (требуется дополнение ASI).
Кабель BNC — BNC, 75 Ом (номер по каталогу Tektronix 174-5135-xx)
поставляется в комплекте.

QB2 2 Интерфейс QAM B (требуется дополнение ASI).
Кабель BNC — BNC, 75 Ом (номер по каталогу Tektronix 174-5135-xx)
поставляется в комплекте.

IPTV  3 Интерфейс IPTV Gb Ethernet с электрическим портом 10/100/1000BASE-
T с соединителем RJ45 (требуется дополнение ASI).
Кабель BNC — BNC, 75 Ом (номер по каталогу Tektronix 174-5135-xx)
поставляется в комплекте.

SX Коротковолновый оптический порт 1000Base-SX с приемо-передающим
устройством SFP, имеющим соединитель типа LC, в качестве
интерфейса IPTV Ethernet (многомодовый, 850 нм).

LX Длинноволновый оптический порт 1000BASE-LX с приемо-передающим
устройством SFP, имеющим соединитель типа LC, в качестве
интерфейса IPTV Ethernet (одномодовый, 1310 нм).

ZX Оптический порт 1000BASE-ZX с приемо-передающим устройством
SFP, имеющим соединитель типа LC, в качестве интерфейса IPTV
Ethernet (одномодовый, 1550 нм).

10GS  4 Двойной оптический порт 10GBASE-SR 10 Гбит/с для использования в
качестве сетевого интерфейса. Включает приемо-передающее
устройство SFP для работы с оптическими линиями малой
протяженности (850 нм) и модули ПО.

1 дополнение S2 (в комплекте с платой DVB-S/S2 с одним входом) более не поставляется; заменяется на дополнение DS2 (в комплекте с платой DVB-S/S2 с
двумя входами).

2 Дополнения VS и QB2 более недоступны.
3 Дополнение IPTV недоступно для приборов MTS4000-EU.
4 Комплект для модернизации аппаратных средств 10GS доступен только для приборов MTS4000 с заводскими номерами B029999 и предшествующими и

недоступен для приборов MTS4000-EU с заводскими номерами B050103 и предшествующими.

принадлежности  
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Дополнение Описание
Обновление ПО
MTS4KUP

TCMP
(только для
MTS4SAV3)

Добавляет анализатор соответствия транспортного потока (Transport
Stream Compliance Analyzer), анализатор Carousel Analyzer,
разделитель транспортных потоков TS Cutter и проигрыватель MPEG в
реальном или замедленном масштабе времени (только для
интерфейса IP)

GEN (Генераторы) Добавляет модули мультиплексора Multiplexer, проигрывателя MPEG
Player, редактора транспортных потоков Transport Stream Editor,
цифрового вещания с интеграцией услуг ISDB-T Remux, Make Seamless
Wizard, разделителя транспортных потоков Transport Stream Cutter и
редактора Script Pad.
Носитель с испытательным потоком Tclips MPEG Test Stream входит в
комплект поставки.

ESS Добавляет модуль ES стандартного анализа элементарного потока. В
комплект поставки включен модуль MTS4CC со всеми дополнениями, а
также анализатор элементарных потоков MPEG-2 ES.

ESB Добавляет функции углубленного анализа элементарного потока.
Включает базовое программное обеспечение MTS4EAV7 (AVC) и
анализатор элементарных потоков MPEG-2 ES.

ESE Добавляет функции углубленного анализа элементарного потока.
Включает ПО MTS4EAV7 со всеми дополнениями (в том числе, HEVC)
и анализатор элементарных потоков MPEG-2 ES.

VQ ПО контроля качества видео с несимметричного входа. Включает ПО
VQS1000 со всеми дополнениями.

PQ Включает ПО анализа качества видео с симметричного и
несимметричного входов. Включает модуль PQASW с дополнением IP.

PB Добавляет анализаторы PES и содержимого буферной памяти T-STD.
V3 Обновление существующего модуля MTS4SA версии 2 до MTS4SAV3
CA Добавляется анализатор субтитров для CEA608, CEA708, SCTE20/21.

Включает модуль MTS4EAV7 связанный с режимом анализа
соответствия CA.

FLT Добавляет плавающую лицензию (все плавающие лицензии включают
одинаковые возможности); для получения нескольких лицензий
следует заказать соответствующее число дополнительных модулей
FLT

 принадлежности
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Восстановление системы MTS4000
При наличии проблем с программным обеспечением системы MTS4000 используйте приведенные в этом разделе
процедуры для восстановления заводских настроек и первоначальной конфигурации.

Полное восстановление системы включает восстановление ОС Windows и переустановку ПО MTS4000 MPEG Test
System.

Восстановление системы затрагивает данные на первичном жестком диске (C:). На вторичный жесткий диск (D:) данные
процедуры не влияют.

ПРИМЕЧАНИЕ. При восстановлении программного обеспечения после замены первичного жесткого диска диском,
заказанным в компании Tektronix, следуйте инструкциям, которые предоставляются с комплектом для замены
жесткого диска.

Восстановление операционной системы
Операционную систему прибора можно восстановить, используя файл на жестком диске прибора или набор DVD для
восстановления ОС. Желательно использовать файл восстановления, хранящийся на жестком диске.

ОСТОРОЖНО. Во избежание потери данных создайте резервную копию важных пользовательских файлов,
хранящихся на жестком диске. В процессе восстановления системы первичный жесткий диск (C:) подлежит
форматированию, что приводит к удалению всех пользовательских файлов и приложений. Вторичный жесткий диск
(D: ) данная процедура не затрагивает.

Если не удается запустить ОС Windows, можно попробовать загрузить последнюю работающую конфигурацию
системы.

Во избежание сбоев не устанавливайте версии ОС Windows, отличные от поставляемой компанией Tektronix с
данным прибором. Данная версия ОС Windows специально настроена на работу с прибором. Другие версии ОС
Windows могут работать с данным оборудованием неправильно.

Восстановление операционной системы с жесткого диска прибора
Файл восстановления операционной системы хранится в приборе в отдельном разделе жесткого диска.

1. Перезапустите прибор. Во время процесса перезагрузки в верхней части экрана появится следующее сообщение:

Starting Acronis Loader… press F5 for Acronis Startup Recovery Manager (Запускается
загрузчик Acronis Loader… для запуска диспетчера восстановления Acronis нажмите клавишу F5).

2. Несколько раз нажмите клавишу F5, пока не откроется программа Acronis True Image Tool. Обычно с момента
появления этого сообщения до того момента, когда продолжится нормальный запуск прибора, проходит 5 секунд.
Если прибор не открывает приложение Acronis, отключите питание прибора, затем снова включите питание и
повторите попытку.

3. Щелкните Recover (Восстановить).

4. В диалоговом окне Confirmation (Подтверждение) щелкните кнопку Yes (Да), чтобы восстановить операционную
систему прибора, или No (Нет), чтобы выйти из процесса восстановления. Процесс восстановления займет
примерно 30 минут. Фактическое время зависит от конфигурации прибора.

5. При появлении запроса выключите или перезагрузите прибор.

6. Установка приложений системы MTS4000
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Восстановление операционной системы при помощи восстановительных DVD
Для восстановления системного ПО прибора требуются восстановительные DVD MTS4000 MPEG Test System Operating
System Restore (063-4387-XX) из комплекта поставки прибора.

1. Вставьте диск 1 из набора Operating System Recovery в DVD-привод прибора и закройте дверцу привода.

2. Перезагрузите прибор.

Если не будет произведена загрузка с DVD, повторите перезагрузку:

■ В процессе загрузки нажмите несколько раз клавишу F11, чтобы вызвать меню загрузки.
■ В качестве загрузочного устройства выберите привод CD/DVD и нажмите Enter. Прибор должен загрузиться с

DVD.

ПРИМЕЧАНИЕ. При необходимости используйте клавиши со стрелками для выбора нужного варианта
восстановления.

3. После появления запроса выберите Recover the original system installation (Восстановить исходную установку
системы) и нажмите Enter.

4. Нажмите Enter для запуска установки. Начнется процесс восстановления.

ПРИМЕЧАНИЕ. Это займет некоторое время. В течение первых десяти минут во время копирования файлов
индикатор выполнения будет оставаться неподвижным.

ПРИМЕЧАНИЕ. Следуйте инструкциям на экране. В ходе процедуры потребуется менять диски в приводе.

Каждый раз при вставке DVD в привод дожидитесь, когда окончит мигать светодиодный индикатор, и только
потом нажимайте кнопки OK или Retry (Повтор). Несоблюдение этого правила приведет к появлению
диалогового окна, приостанавливающего установку до нажатия кнопки OK.

5. После завершения восстановления средствами Acronis извлеките восстановительный диск из привода.

6. При появлении запроса выберите перезапуск или выключение прибора, для того чтобы завершить восстановление
ОС.

7. При появлении запроса Windows выберите Restart Now (Перезагрузить сейчас) для перезагрузки прибора и
завершения установки всех драйверов устройств.

8. Установка приложений системы MTS4000

Установка приложений системы MTS4000
Процедура установки приложений системы MTS4000 аналогична процедуре автономной установки.

При установке приложений MTS4000 на платформу MTS4000 выберите в программе установки пункт Install on MTS4000
Platform (Установка на платформу MTS4000).
 

Восстановление системы MTS4000  
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После установки приложений MTS4000 необходимо заново установить программный лицензионный ключ. Это также
описано в процедуре автономной установки. См. Установка автономной системы MTS4SAV3 на странице 17.

 Восстановление системы MTS4000
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Техническое обслуживание, выполняемое
пользователем

В данном приложении приведены процедуры по уходу за системами тестирования MPEG и их обслуживанию. 

■ В разделе Профилактическое обслуживание содержатся инструкции по очистке устройства
■ В разделе Устранение проблем даются рекомендации по устранению неполадок загрузки
■ В разделе Возвращение прибора для обслуживания приведены инструкции по упаковке и транспортировке прибора

Общий уход
Оберегайте прибор от воздействия неблагоприятных погодных условий. Прибор не защищен от проникновения воды.

ОСТОРОЖНО. Чтобы избежать повреждения прибора, не подвергайте его воздействию распылителей, жидкостей
или растворителей.

Не пользуйтесь химическими чистящими средствами, они могут повредить прибор. Избегайте использования химикатов,
содержащих бензол, толуол, ксилол, ацетон и другие похожие растворители.

Профилактическое обслуживание
Проверяйте технические характеристики и сертификацию калибровки прибора раз в год.

Профилактическое обслуживание состоит главным образом в периодической очистке. Периодическая очистка понижает
вероятность отказов прибора и увеличивает его надежность. Очистку прибора следует выполнять в соответствии с
внешними условиями его эксплуатации. В помещениях с сильным загрязнением требуется более частая очистка по
сравнению со специализированными помещениями для компьютеров.

Очистка внешних поверхностей
Чистка внешних поверхностей прибора выполняется сухой тканью, не оставляющей волокон, или мягкой щеткой.
Оставшееся загрязнение может быть удалено мягкой тканью или тампоном, смоченным в 75-процентном растворе
изопропилового спирта. Тампон на стержне можно использовать для чистки труднодоступных мест возле органов
управления и разъемов. Не используйте для чистки какой-либо части прибора абразивные вещества.

ОСТОРОЖНО. Чтобы предотвратить попадание влаги внутрь прибора при внешней чистке, не используйте
жидкости больше, чем это необходимо для увлажнения ткани или тампона. Используйте 75-процентный раствор
изопропилового спирта в качестве чистящего средства, остатки раствора следует удалять деионизированной
водой.

Не промывайте выключатель On/Standby (Включение/ожидание) на передней панели. Закрывайте выключатель во
время чистки прибора.
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Чистка клавиатуры
Чистка внешних поверхностей клавиатуры и встроенного трекпада выполняется сухой тканью, не оставляющей волокон,
или мягкой щеткой. Тампон на стержне можно использовать для чистки труднодоступных мест возле органов управления
и разъемов. Не используйте для чистки какой-либо части прибора абразивные вещества.

ОСТОРОЖНО. Чтобы предотвратить попадание влаги внутрь клавиатуры и встроенного трекпада при внешней
чистке, не используйте жидкости больше, чем это необходимо для увлажнения ткани или тампона. Используйте 75-
процентный раствор изопропилового спирта в качестве чистящего средства, остатки раствора следует удалять
деионизированной водой.

Техническое обслуживание, выполняемое пользователем  
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Устранение проблем
Настоящий раздел посвящен решению проблем, которые могут возникнуть при эксплуатации системы тестирования. В
этом разделе не рассматриваются специфические проблемы, связанные с проверкой работоспособности или с
настройками. Диагностические процедуры для тестовой системы MTS4000, приведенные в данном разделе, помогут
локализовать неполадки. Процедура проверки работоспособности описана в документе Справочное руководство по
техническим характеристикам и проверке рабочих характеристик прибора MTS4000, поставляемом в форме PDF-
файла на компакт-диске Документация к продукту MTS4000.

Внутренняя диагностика выполняется при первом включении питания прибора для запуска приложения системы
тестирования. Схема диагностики проверяет операционную систему и аппаратные средства для обеспечения
корректной работы. Наличие сообщений об ошибках во время диагностики при включении питания свидетельствует о
возможных неполадках, которые препятствует запуску программного обеспечения системы MTS4000.

В следующей таблице перечислены некоторые признаки аппаратных неполадок, связанных с операционной системой и
периферийными устройствами, и возможные методы их устранения.

Признак Возможные причины и рекомендуемые действия
Не включается питание прибора Проверьте, подключен ли силовой шнур к прибору и к

источнику электропитания.
Проверьте подачу питания в прибор при нажатии
переключателя On/Standby (Включение/ожидание);
проверьте работу вентилятора.
Убедитесь, что источник питания обеспечивает нужное
напряжение.
Обратитесь в центр обслуживания Tektronix вашего
региона.

Прибор включается, но процесс включения не завершается Убедитесь, что прибор загружается с жесткого диска.
Сбой диагностики при включении питания Обратитесь в центр обслуживания Tektronix вашего

региона.
Прибор не распознает периферийные устройства,
например внешний монитор, принтер или клавиатуру

Удостоверьтесь, что периферийные устройства
надлежащим образом подключены и настроены.
Обратитесь в центр обслуживания Tektronix вашего
региона.

Прибор не выключается с помощью переключателя On/
Standby (Включение/ожидание)

Попытайтесь выключить прибор, используя процедуру
завершения работы Windows 7. Если прибор снова не
выключается, используйте диспетчер задач, чтобы закрыть
задачу. Наконец, используйте аппаратную процедуру
завершения работы: нажмите и удерживайте
переключатель On/Standby (Включение/ожидание) в
течение пяти секунд — прибор должен выключиться.
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Проблемы, связанные с программным обеспечением
Система тестирования MPEG поставляется с предустановленным программным обеспечением. При наличии
подозрений в отношении ПО попытайтесь изолировать проблему, проверив системное ПО или другие установленные
приложения.

Много программных сбоев связано с повреждением файлов ПО или с их отсутствием. В большинстве случаев самый
простой способ решить программные проблемы состоит в том, чтобы повторно установить программное обеспечение.
См. Восстановление системы MTS4000 на странице 77.

Если предполагается, что проблемы связаны с сетью, см. раздел Устранение неполадок c сетью на странице 9. 

Неисправности оборудования
Неисправности оборудования могут быть вызваны различными причинами. Просмотрите инструкции по установке,
приведенные в настоящем руководстве по эксплуатации, чтобы удостовериться, что прибор должным образом
подготовлен к работе. Система MTS4000 не содержит компонентов, которые можно заменить или отремонтировать
силами пользователя, поэтому при обнаружении неисправностей оборудования необходимо связаться с
представителем центра обслуживания Tektronix вашего региона.

Восстановление значка TSCA P1
Если значок TSCA P1 был случайно удален из папки Real Time Analysis на рабочем столе, его можно восстановить,
выполнив следующие действия.

1. Скопируйте значок TS Compliance Analyser из папки Real Time Analysis на рабочем столе или из меню «Пуск».

2. Щелкните этот значок правой кнопкой мыши и выберите пункт Properties (Свойства).

3. Откройте вкладку Shortcut (Ярлык).

4. В поле Target (Объект) добавьте /p1 в конец строки. Подученная в результате строка должна иметь вид:

"C:\Program Files (x86)\Tektronix\mpeg\MTS4000\Apps\TSCA\bin\TSCA.exe" /p1

ПРИМЕЧАНИЕ. Убедитесь, что между завершающей кавычкой “ и /p1 есть пробел.

5. Переименуйте ярлык, добавив P1 в конец его имени.

Возвращение прибора для обслуживания
При упаковке прибора для отправки используйте оригинальную упаковочную тару. Если упаковочная тара отсутствует
или не пригодна для использования, обратитесь в региональное представительство корпорации Tektronix, чтобы
получить новую упаковочную тару.

1. Заклейте упаковочную картонную коробку клейкой лентой или закрепите с помощью специального степлера. Перед
возвращением прибора для проведения обслуживания свяжитесь с сервисным центром для получения номера RMA
(номер авторизации возврата) и необходимой информации.

2. Если производится отправка прибора в сервисный центр Tektronix, включите следующие сведения:

■ Номер RMA.
■ Адрес владельца.
■ Имя и номер телефона контактного лица.
■ Тип и серийный номер прибора.
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■ Причина возврата.
■ Полное описание требуемого обслуживания.

3. Нанесите адрес сервисного центра Tektronix и обратный адрес на почтовую коробку в двух хорошо заметных
местах.
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